Contents

Photon_Documentation_v9

01_01_Before Starting Photon 1
  Requirements for PHOTON 1
  1.1 PHOTON Installation 1
  1.2 VYV Network Assistant Installation 1
  1.3 Network Configuration 2
  1.4 Remote Install/Uninstall 3
    1.4.1 Install a new version of PHOTON 3
    1.4.2 Uninstall a version of PHOTON 4
  1.5 Project Configuration 4
    Configuration Procedure 5
    Launch PHOTON with Arguments 6
    VYV Network Assistant Autolaunch 7
    PHOTON Autolaunch 7
    Autolaunch and Shutdown Delays 7
  1.6 Graphic Card Configuration 8
    1.6.1 Before Opening the NVIDIA Control Panel 8
    1.6.2 Open the NVIDIA Control Panel 10
    1.6.3 Manage 3D Settings 10
    1.6.4 Change Resolution 11
    1.6.5 View System Topology 11
      Export 12
      Load 13
      Unload 13
      1. Select Topology 14
      2. Select Displays 15
      3. Arrange Displays 15
      4. Numbering 15
      5. Adjust Overlap and Bezel Correction 16
      6. Confirmation 16
  1.7 Launch/Quit PHOTON 16
    1.7.1 Launch PHOTON 17
    1.7.2 Quit PHOTON 17
  1.8 Reboot/Shutdown Servers 17
    1.8.1 Reboot 17
1.8.2 Shutdown

01_02_Fundamentals of Photon and its UI 18

2.1 User Interface Visibility 18
2.2 Layer Rendering Order 19
2.3 Virtual and Physical Screens 19
2.4 Internal and External Data Exchange 20
2.5 Metric System Only 21
2.6 Real-Time Everywhere 21
2.7 Normalized Values 21
2.8 UI Components Lexicon 22
    Module 22
    Window 22
    Window Section 23
    Tab 24
    Listst 25
    Main Menu 25
    Dropdown Menu 25
    Contextual Menu 26
    Slider 26
    Toggle 26
    Button 27
    Checkbox 27
2.9 Renaming Labels 27
2.10 Main Menu Bar 27
2.11 Saving Methods 28
    Save Default 29
    Load Default 29
    Save Incremental 29
    Save Project… 29
    Load Project 30
2.12 Slider Types and Behaviors 30
    1D Slider 30
    2D Slider 31
    Time Slider 31

02_01_Settings 33
1.1 PHOTON Network 33
    1.1.1 Server Group Creation 33
    1.1.2 Removing Servers from a Server Group 34
1.1.3 Remove and Shutdown PHOTON 35
1.1.4 Multiple Server Groups 35
1.1.5 Monitoring and Troubleshooting 35
   Physical Network Connections 36
   IP Addressing 36
   Traffic Management 36
   Network Ports (within PHOTON) 36
1.1.6 Network Ports 37
   Time Sync Port 37
   Data Sync Port 37
   Show Control Port 37
Fig. 02.01_1.1.6 37
1.2 Server Operation Modes 37
   1.2.1 Hierarchy 38
   1.2.2 Computer Vision 38
   1.2.3 Operation Modes 38
      Controller 38
      Display 39
      Display Master 39
      Albion 39
1.3 Camera Attribution and Server Modes 40
   Camera Segregation 41
   Sequential Access 41
   Albion and Controller Running on the Same Server 41
1.4 I/O Control Attribution and Server Modes 41
1.5 Windowing for the User Interface (UI) and the Video Outputs 42
   1.5.1 Auto Window Creation 42
   1.5.2 Draw Canvas View 43
   1.5.3 Hide/Show the User Interface Locally 43
   1.5.4 Hide/Show the User Interface Remotely 43
1.6 Virtual Video Output Creation 43
   1.6.1 Virtual Video Output 44
      Virtual Video Output Resolution for Display Servers and Display Master Servers 45
      Video Outputs Resolution for Controllers 46
   1.6.2 Signal Routing Validation through Display Ident 46
   1.6.3 Virtual Video Output Assignation Dropdown Menus 48
   1.6.4 Video Output Assignation and Backup Servers 48
2.4 Manual 3D Calibration

2.4.1 Add a Projector in the 3D Scene
   Automatic Projector Creation 69
   Manual Projector Creation 69
   Renaming a Projector 70

2.4.2 Add a 3D Object in the 3D Scene 71

2.4.3 Scale, Translate and Rotate the 3D Object 71
   Why Apply 3D Transformations? 72
   Applying 3D Transformations 72
   Transformations Panel 72
   Transformation Manipulators 74

2.4.4 Freeze Transformations 75
   Freeze an Object 75
   Why Freeze? 75

2.4.5 Map the 3D Object to the Display 76

2.4.6 Calibration Point Creation and Manipulation 79
   Calibration Point Creation 79
   Calibration Points, Crosses and Lines 80
   Manipulating Calibration Points 81
   Keyboard Calibration Point Manipulations 81
   Mouse and Keyboard Calibration Point Manipulations 82

2.5 Projection Surfaces Visibility 83
   Adding a Projection Surface to the Objects Visibility List 83
   Removing a Projection Surface from the Objects Visibility List 84
   Blanking a Projection Surface from the Objects Visibility List 85

2.6 Convergence and Seamless Projection 85
   2.6.1 Convergence 86
   2.6.2 Seamless Projection 86

2.7 Display Soloing 87
   Solo a Display 87

2.8 Default Camera Selection 88

2.9 Blending 89
   Enable Blending and Select Blending Mode 89
   p-space 3.5 (RT GPU) 90
   p-space 3.5 (static) 90
   p-space 3.4 (GPU) 90

2.10 Calibration Lock 91
   Locking a Calibration 91
1.1.1 Open the Cue Editor 129
1.1.2 Toggle Full View or List View 130

1.2 Cue Recording 131
1.2.1 Create a New Cue 131
1.2.2 Record Actions in a Cue 131

1.3 Editing the Cue Actions List 132
1.3.1 Reorder Actions in a Cue 132
1.3.2 Delete, Duplicate or Rename Actions in a Cue 132

1.4 Modifying Cues 133
1.4.1 Delay 133
1.4.2 Offset and Multiple Delays 133
1.4.3 Timing 133
1.4.4 Target Values 134
1.4.5 Easing 134

1.5 Rename, Duplicate or Delete Cues from the Cue List 134
1.5.1 Rename a Cue 134
1.5.2 Duplicate a Cue 134
1.5.3 Delete a Cue 134

1.6 Nested Cues 135
1.6.1 Nesting a Cue 135

1.7 Cue Playlists 135
1.7.1 Create a Cue Playlist 135
1.7.2 Add a Cue to a Cue Playlist 135
1.7.3 Remove a Cue from a Cue Playlist 136

1.8 Triggering a Cue 136
1.8.1 Manual Trigger 136
1.8.2 Timeline Trigger 136
1.8.3 Midi Trigger 136
1.8.4 UDP Trigger 136

04_02_Timeline 137

2.1 Sequences, Screens, Layers and Clips 137
2.1.1 Sequences 137
    Select a Sequence 138
    Create a Sequence 138
    Delete a Sequence 138
2.1.2 Screens 138
    Create Screens 139
    Collapse and Expand Screens 139
Add Screen Metadata 139
Screen Render Resolution 140
Search for a Screen 141
The Root 142

2.1.3 Layers 142
Create New Layers 143
Reorganize the Layer Order 143
Layer Rendering Order 143

2.1.4 Clips 143
Add Clips 144
Select a Single Clip 145
Select Multiple Clips 145
Delete Clips 145
Change Clip Type 145
Change Clip Colors 145
Reset Clip Colors 146

2.2 Clip Types 146
Empty Clip [Ctrl+N] 146
Media Clip [Ctrl+M] 146
FX Stack Clip [Ctrl+E] 147
FX Graph Clip [Ctrl+W] 147
Virtual Projector Clip [Ctrl+R] 147
Input Device Clip [Ctrl+I] 148
Cue Clip [Ctrl+U] 148
Proxy Clip [Ctrl+P] 148
Composer Clip [Ctrl+G] 149
Composition Clip [Ctrl+H] 149
Shadow Session Clip [Ctrl+O] 149

2.3 Screen and Layer Timeline Properties 150
Cancel Rendering for a Screen or Layer 150
Lock a Screen or Layer 150
Hide a Screen or Layer 150
Modify Alpha for a Screen or Layer 150

2.4 Add or Replace Media 150
Add Media 150
Add a Specific Media File as a Media Clip in the Timeline 151
Replace the Media File linked to a Media Clip 151
### 2.5 Timeline Navigation

#### 2.5.0 The Playhead

#### 2.5.1 Playhead Positioning
- Position Playhead using the Mouse
- Position Playhead using the Time Box
- Other Ways to Position the Playhead

#### 2.5.2 Timeline Zoom and Navigation
- Zoom and Navigation using the Mouse and Keyboard
- Zoom and Navigation using the Zoom Bar

#### 2.5.3 Re-center the Playhead

#### 2.5.4 Scroll and Pan on the Timeline
- Scroll
- Pan

#### 2.5.5 J K L

#### 2.5.6 Navigate Timeline Using Ins and Outs

### 2.6 Editing on the Timeline

#### 2.6.1 Move Clips

#### 2.6.2 Change Clip Duration

#### 2.6.3 Set a Clip’s In or Out Point
- Set Clip In Point
- Set Clip Out Point

#### 2.6.4 Set Clip Fade In/Out Points
- Set Clip Fade In Point
- Set Clip Fade Out Point

#### 2.6.5 Trim Clip In or Out Point
- Trim Clip In Point
- Trim Clip Out Point

#### 2.6.6 Duplicate Clip

#### 2.6.7 Slice Clip

#### 2.6.8 Snapping

### 2.7 Inserting Cues on the Timeline

#### 2.7.1 Add a Cue Clip

#### 2.7.2 Adjust a Cue Clip’s Length and Position

#### 2.7.3 Link the Cue Clip to a Pre-Programmed Cue

### 2.8 Universal Crossfade

- Enable Universal Crossfade
- Set Universal Crossfade Duration

### 2.9 Timeline Duration
1. Before Starting PHOTON

Requirements for PHOTON
Windows 7 (and above)
NVIDIA GPU

1.1 PHOTON Installation

1. After retrieving the installer (.exe) — downloaded from our website, or sent to you by a PHOTON Specialist — double click on the (.exe) file. (You might have to answer a Windows security question.
2. Choose the destination folder (it is usually C:\VYV or P:\VYV).
3. Click on the [Install] button, wait for the installation process to complete, and then click on the [Close] button.

1.2 VYV Network Assistant Installation

The VYV Network Assistant is an external tool that runs independently of PHOTON. It allows you to:
● manage the version of PHOTON you are using;
● install and uninstall different versions of PHOTON;
● manage your PHOTON Projects;
● start PHOTON with arguments (for example, no UI or no splash screen on startup);
● restart PHOTON;
● quit PHOTON;
● reboot the server;
● shutdown the server.

Note: All of the above actions can be propagated across the network on any number of connected servers.

The VYV Network Assistant makes it possible to automatically launch a specific version of PHOTON and start a specific project after Windows boots.

1. After retrieving the installer (.exe) — downloaded from our website, or sent to you by a PHOTON Specialist — double click on the (.exe) file. (You might have to answer a Windows security question.)
2. Choose the destination folder (it is usually C:\VYV or P:\VYV).
3. Click on the [Install] button, wait for the installation process to complete, then click on the [Finish] button. A prompt window will open right away, asking you to start the VYV Network Assistant.

Note: The VYV Network Assistant needs to be manually installed on all servers.

1.3 Network Configuration

PHOTON servers need to be assigned static IP addresses and must reside on a dedicated network. All of your servers should be connected to a network switch.

Make sure your servers and network switch share the same network prefix and subnet number (the first 3 octets in the IP address).

The network switch’s host number (last octet in the IP address) should be 1. The network switch will probably use a browser-based interface to allow parameter modifications. The host numbers for the servers can range from 2–254.

Make sure that the network interface you are using is the first one being accessed by Windows’ network services. In order to do this:
1. Go to {Control Panel > Network and Sharing Center > Change Adapter Settings};
2. Press the [Alt] key to display the Advanced menu;
3. Select {Advanced > Advanced Settings}.

The Advanced Settings window (Adapters and Bindings tab) will display the network interfaces list. You can change the order of the network interfaces by selecting them individually and pressing the up/down arrows.

1.4 Remote Install/Uninstall

After all of the servers are communicating on the same network and have fully functional versions of the VYV Network Assistant installed, you will be able to execute the following actions on all servers from one server using the VYV Network Assistant’s interface.

The PHOTON versions directory is located under ...\VYV\PHOTON\versions\...

1.4.1 Install a new version of PHOTON

1. Select the servers you want to install the new version of PHOTON onto by checking the boxes located on the left side of the Systems list.
2. When selected, the servers will be identified by a green check mark. The server you are using as the control interface will have (LOCAL) in front of its name. Select {Tools > Remote Install...} from the menu bar or press [Alt+I] to open the Remote Installation pop-up window.
3. Press the [...] button to open a Windows file dialog.
4. Select the PHOTON installer (.exe) and press [Open]. A confirmation box will appear showing the list of servers where you will remotely install PHOTON.
5. Press [Yes] if you want to proceed, or [Cancel] if you don’t. Installation progress will be indicated in the Status column. The newly installed version of PHOTON will be available in the System Configuration pop-up window.
1.4.2 Uninstall a version of PHOTON

1. Select the servers targeted for the uninstall PHOTON process by checking the boxes located on the left side of the Systems list.
2. When selected, the servers will be identified by a green check mark. The server you are using as the control interface will have (LOCAL) in front of its name.
3. Select {Tools > Remote Uninstall...} from the menu bar or press [Alt+U] to open the Remote Uninstall pop-up window.
4. Select PHOTON in the (Product) dropdown menu.
5. Select the PHOTON version you want to uninstall from the {Version} dropdown menu.
6. A confirmation box will appear showing you the list of servers targeted for the Remote Uninstall process. Press [Yes] if you want to proceed, or [Cancel] if you don’t.

1.5 Project Configuration

Project configuration will allow you to select which version of PHOTON will run on your Server Group. It will also allow you to create new PHOTON Projects or load previous ones.

A PHOTON Project consists of an independent set of folders that contain important files such as media content, 3D models, saves, and various configurations targeting network and third party hardware. Keep in mind that a new Project will not have access to the files used in previous Projects.
Once you have selected the desired configuration options (see below), press [Apply] to propagate the changes over the network or [Cancel] to discard them.

Note: The PHOTON Project directory is located under ...\VYV\PHOTON\projects\...

**Configuration Procedure**

1. Select the servers you want to configure by checking the boxes located on the left side of the Systems list. Project configuration will be pushed via the network to all of the selected servers.

2. When selected, the servers will be identified by a green check mark. The server you are using as the control interface will have (LOCAL) in front of its name.

3. Select {Tools > Configure...} from the menu bar or press [Alt+C] to open the System Configuration pop-up window.

4. Select PHOTON in the {Product} dropdown menu.

   ![VYV Network Assistant](image)

If you want to create a new PHOTON Project:
   - select {New...} at the top of the {Project} dropdown menu;
   - type the name of your Project in the text box.

If you want to load an existing PHOTON Project:
   - select the Project you want to use from the {Project} dropdown menu.
Launch PHOTON with Arguments

An argument instructs PHOTON to perform special operations when the program is launched.

Arguments can be selected in the System Configuration window.

1. Select {Tools > Configure…} from the main menu or press [Alt+C] to open the System Configuration window.
2. Arguments can also be manually typed into the Arguments text box, or added by pressing the [+] button. The [+] button will prompt the Command Line Arguments pop-up window.
3. Select the desired arguments from the list by checking their boxes. When selected, the arguments will be identified by a green check mark. This will push the selected arguments to all of the servers via the network.

Available Arguments

Hide User Interface (UI) on Startup
The UI will not appear on startup, but it can be accessed by pressing the [Tab] key. This option might be useful if your server is a Display Master Server and you are using all of its video outputs to display video content.
Keep Taskbar
The Windows taskbar usually disappears when PHOTON launches and reappears when it is closed. Selecting the Keep Taskbar option will make the Windows taskbar available.

Keep Windows 7 Aero
By selecting this option, Windows 7 Aero functionality will not be deactivated when PHOTON is launched. This might impact performance, but Aero simplifies window capture during Teamviewer sessions.

Disable OptiTrack Cameras
Disabling OptiTrack cameras will prevent PHOTON from accessing the OptiTrack library and discovering the networked cameras. This might be helpful in a troubleshooting situation, where the computer vision system needs to be isolated.

Disable Splash Screen
This option will prevent PHOTON's splash screen from being displayed on startup.

VYV Network Assistant Autolaunch
If you want the VYV Network Assistant to automatically start after Windows launches, check the box in front of “Run Network Assistant on System startup” (a green check mark will appear).

PHOTON Autolaunch
If you want PHOTON to automatically start after the VYV Network Assistant launches, check the box in front of “Run Local Target when Network Assistant starts” (a green check mark will appear).

Autolaunch and Shutdown Delays
If you want to delay PHOTON’s launch after the VYV Network Assistant’s boot procedure, change the value (seconds) in the Run Local Target Timeout(s) slider. This could be useful, for example, if you have network latency problems (i.e. the network switch is slow to wake up).

Note: This timeout is only applied if PHOTON is auto-launched using parameters set by the VYV Network Assistant.
If you want PHOTON to shutdown after the VYV Network Assistant’s launch, change the value (seconds) in the Quit Local Target Timeout(s) slider. This could be useful, for example, if the Project you are working on uses a lot of memory and needs more time to complete a Default Save procedure.

Note: When PHOTON quits, the software automatically saves in the Default Save file (see Section 2.10 Saving Methods in Chapter 1 Prerequisites).

Note: This timeout is only applied if PHOTON quits by means of a command sent by the VYV Network Assistant.

### 1.6 Graphic Card Configuration

NVIDIA’s Mosaic technology allows you to create a large virtual canvas with all of the displays that are connected by combining them into one large screen. This larger unique canvas reduces the impact on performance when using 2D or 3D applications in a multi-display situation. PHOTON will still be able to identify each video output as an individual screen.

Note: NVIDIA Mosaic is a requirement for maximum performance when using PHOTON.

Follow the steps listed below to build a Mosaic display group.

#### 1.6.1 Before Opening the NVIDIA Control Panel

1. Physically connect your video displays (projectors, monitors, LED screens, etc.) to the server.

Note: Even though Quadro cards have 5 connectors, only 4 will work at the same time.

2. Make sure the video signal goes to all of the displays by changing the Windows desktop color:
   a. Click on the [Windows Start] button and select {Control Panel > Personalization};
   b. Select Desktop Background at the bottom of the window;
   c. Select Solid Colors from the {Picture Location} dropdown menu and choose a bright color;
   d. Press [Save Changes] if you want to keep the color, press [Cancel] if you want to return to the previous color;
   e. You should see bright color in all displays.

Note: When PHOTON starts the desktop background will automatically turn black.

3. You can also check the Windows display settings to make sure all of your displays are recognized.
4. Right-click anywhere on the Windows desktop background and select Screen Resolution in the contextual menu, or click on the [Windows Start] button and select {Control Panel > Screen Resolution}.
5. You should see all of the displays that are connected. Display numbering starts at 1.

6. Make sure all of your displays are set at a resolution recognized by Windows, and that they are all in Extend Mode. (Make sure the screens are not cloning one another.)
1.6.2 Open the NVIDIA Control Panel

1. Right-click anywhere on the Windows desktop background and select NVIDIA Control Panel from the contextual menu, or click on the [Windows Start] button and select {Control Panel > NVIDIA Control Panel}.

1.6.3 Manage 3D Settings

1. Make sure the driver settings are correct.
2. Select {Manage 3D Settings} in the “Select a Task…” list under {3D Settings}. Make sure the Global Settings tab is selected.
4. In the Settings list below:
   a. set the Power Management Mode to “Prefer maximum performance”;
   b. set Triple Buffering to “On.”
5. If you make any changes press the [Apply] button on the lower left side of the panel.
1.6.4 Change Resolution

1. Select {Change Resolution} in the “Select a Task…” list under {Display}.
2. You should see all of your connected displays represented as small icons that look like monitor screens. By selecting these icons you can adjust the resolution, refresh rate and depth of color for each video output. Make sure that all of your video outputs have the same parameters.
3. If you make any changes press the [Apply] button at the lower left side of the panel. An “Apply Changes” confirmation box with a 17-second timeout will appear. Press [Yes] to apply changes, or [No] to cancel changes.

Note: To set up a Mosaic display group all of your video outputs must be set at the same resolution and refresh rate.

1.6.5 View System Topology

1. Select {View System Topology}.

The Quadro cards feature Extended Display Identification Data (EDID) management. (Please refer to https://en.wikipedia.org/wiki/Extended_Display_Identification_Data for more info.)
EDID management allows you to force a similar behavior on all of your video outputs by pushing the same manufacturer metadata onto them. This will allow you to hot swap displays without breaking the Mosaic configuration, while facilitating its creation.

2. Select {View System Topology} in the “Select a Task…” list under {Workstation}.
3. Select any of the EDID links in the Settings column of the System Topology table. This will prompt a Manage EDID window with 3 tabs:

   **Export**

   Export will allow you to grab the EDID in a (.txt) file from a display connected to the graphic card.

   a. Click on the Export tab.
   b. In the Select Connector to Export EDID list, select the display from which you want to export the EDID.
c. Press the [Export EDID] button at the bottom of the window. A Save As Windows file dialog will prompt you to select the destination where the file will be saved.
d. Name your text file. Give it the same name as the display.
e. Press the [Save] button.

Load
The Load tab will allow you to load the EDID onto all of the selected displays, forcing all of the video outputs to use the same manufacturer metadata.

a. Click on the Load tab.
b. Press the [Browse] button at the top of the window.
c. An Open Windows file dialog will prompt you to select the EDID file (.txt) you want to load.
d. Press the [Open] button.
e. In the Select Connector to Force EDID list, select the displays you want to load the EDID onto by checking the boxes beside their name.
f. Press the [Load EDID] button.
g. You will see a black flash in the connected displays.
h. A pop-up will confirm the Load procedure was successful.
i. Press the [OK] button.

Note: Don’t load EDID in video outputs that aren’t connected to a display. It can create ghost video outputs.

Unload
The Unload tab allows you to remove a Forced EDID from the selected video outputs to regain the original display’s metadata.

a. Click on the Unload tab if you wish to do so.
b. In the Select Connector to Unload EDID list, select the displays you want to unload Forced EDIDs by checking the boxes beside their name.
c. Press the [Unload EDID] button.
d. You will see a black flash in the connected displays.
e. A pop-up will confirm the Unload procedure was successful.
f. Press the [OK] button. Once all of the connected video outputs have the same EDID, go back to Change Resolution. Make sure each display has the same resolution and refresh rate.

Note: If you use HDMI connectors, make sure all video outputs are set at Full in the {Output Dynamic Range} dropdown menu.
1.6.6 Set Up the Mosaic Display Group

Now you are ready to set up your Mosaic display group.

1. Select {Set Up Mosaic} in the “Select a Task…” list under {Workstation}.
2. Click the Create new configuration link. This will open the NVIDIA Mosaic set up window.

Follow the next 5 steps to create your Mosaic display group:

1. Select Topology
   a. Select the number of displays you want to include in the Mosaic display group with the help of the dedicated dropdown menu. **You must include all of your available video outputs in the Mosaic configuration.**
b. Select your Topology — how the displays will be positioned on the grid — with the help of the dedicated dropdown menu. **Always use a single row topology (1 X ...) because PHOTON works through horizontal screen spanning.**

c. Select the display Orientation with the help of the dedicated dropdown menu. **Always use Landscape even if your project includes rear projections or projectors set up in portrait format. PHOTON will automatically manage these cases.**

d. If your screens are listed correctly and placed in the right order you can immediately check the box next to “I am using the recommended connections for the selected topology” and press the [Enable Mosaic] button. This will open the “Apply Changes” confirmation window. If the Mosaic display group seems to be set up correctly, click on the [Yes] button. You should be ready to launch PHOTON now. If not, click on the [No] button and go through the next steps.

2. Select Displays
   a. All of the available displays listed underneath “Displays for Mosaic” should already be checked. If not, check the boxes next to their names.
   b. Select the desired refresh rate in the {Refresh Rate} dropdown menu.
   c. Select the desired resolution in the {Resolution Per Display} dropdown menu.
   d. Press the [Next] button.

3. Arrange Displays
   a. Arrange your displays by dragging them from the top of the panel to the white rectangles located in the bottom section. This will set their placement in the Mosaic large canvas.
   b. You can also type the display numbers into the white rectangles and press [Enter]. (Each display is identified by the large number in the top-left corner.)

4. Numbering
   As mentioned above, displays are identified by numbers. The numbers indicate the order in which the displays are connected to the graphics card: display #1 is connected to the output port closest to the motherboard, display #2 is connected to the next output port, and so on. This system for prioritizing displays by using numbers that represent their proximity to the motherboard applies to the other output ports as well.

   The small-number pairs displayed in the lower-left corner of the displays represented are another element of this prioritization system. The first number (before the comma) represents the hierarchical position of the graphics card (starting at 0). The second number (after the comma) represents the hierarchical position of the output ports on the graphic card (starting at 0).
a. When the displays are in the correct order, press the [Apply] button. An “Applying Changes” loading bar will appear, and you will see a black flash in all of the connected displays. (This might take a while.)
c. The upper section of the window, where the drag and drop displays were initially placed, will have changed. A pop-up window should tell you that the “Mosaic is enabled.”
d. You can still reorder the displays by dragging and dropping them, but you will have to go back and Apply Changes again.
e. The Mosaic display group’s maximum resolution will be written near the bottom of the window.
f. Press the [Finish] button. (Don’t press [Next].)

5. Adjust Overlap and Bezel Correction
Do not adjust overlap and bezel because PHOTON will take care of these issues while calibrating.

6. Confirmation
a. The Set Up Mosaic window will have changed, and will present a summary of the current Mosaic configuration. If you wish to make changes, use the [Modify] button or the [Disable] button.
b. You can also find out if the Mosaic display group is recognized in the Windows display settings. Right-click anywhere on the Windows desktop background and select {Screen Resolution} in the contextual menu, or click on the [Windows Start] button to access {Control Panel > Screen Resolution}.
c. You should see a single monitor representing all of the connected displays. It should be #1.
d. Now you have a Mosaic display group and you are ready to launch PHOTON.

1.7 Launch/Quit PHOTON
VYV recommends using the VYV Network Assistant to launch or quit PHOTON.

1. Begin by launching the VYV Network Assistant.
2. Once the VYV Network Assistant window is open, select the servers you want to affect by checking the boxes situated on the left side of the Systems list.

When selected, the servers will be identified by a green check mark. The server you are using as the control interface will have (LOCAL) in front of its name.
1.7.1 Launch PHOTON

- Press the [Restart Program] button at the bottom of the VYV Network Assistant window. This action will remotely start or restart PHOTON on all of the servers selected in the Systems list.

1.7.2 Quit PHOTON

- Press the [Quit Program] button at the bottom of the VYV Network Assistant window. This action will remotely shutdown PHOTON on all of the servers selected in the Systems list.

Note: When PHOTON is running you might have to press [Alt+Tab] to bring the VYV Network Assistant back in order to simultaneously quit the application on all servers. You can also bring the VYV Network Assistant back by using a button in the Settings module Network tab.

Note: When PHOTON quits, the software is automatically saved in the Default Save file (see 2.9 Saving Methods in Chapter 2 Prerequisites).

Note: While PHOTON is shutting down you will see a Windows console prompt. Don’t shut it down. You will crash the system and prevent PHOTON from creating a Default Save file.

1.8 Reboot/Shutdown Servers

- Select the servers you want to reboot or shutdown by checking the boxes located on the left side of the Systems list.

When selected, the servers will be identified by a green check mark. The server you are using as the control interface will have (LOCAL) in front of its name.

1.8.1 Reboot

- Press the [Reboot System] button at the bottom of the VYV Network Assistant window. This action will remotely reboot all of the servers selected in the Systems list.

1.8.2 Shutdown

- Press the [Shutdown System] button at the bottom of the VYV Network Assistant window. This action will remotely shutdown all of the servers selected in the Systems list.
2. Fundamentals of PHOTON and its User Interface

2.1 User Interface Visibility

By default PHOTON’s interface will not be visible on start-up. This is due to the fact that on some configurations (when the Display Master operation mode is selected) every physical output of the graphic card will be used to display content.

- Press [Tab] to hide or view PHOTON’s UI.
2.2 Layer Rendering Order

In PHOTON, the rendering order is organized from top to bottom. This means the lowest item in the list will always be the last one rendered, and as a result it will be placed on top of the composition. This applies to both the Timeline module (where compositing is done) and the 3D Scene list.

It is important to remember that the logic of PHOTON’s rendering order is the inverse of Adobe’s image compositing applications.

2.3 Virtual and Physical Screens

PHOTON has been designed to facilitate the creation of shows that involve complex programming, signal distribution and display of video content, and also include interactions with various sensor feeds or external devices.

A key characteristic of a powerful, efficient and easy to use software designed specifically for video projection in stage productions should be to represent reality as accurately as possible. Therefore, PHOTON is based on a virtual representation of a physical stage’s three-dimensional space and its components. The virtual counterparts of projectors, screens, LED displays, lighting fixtures and stage props can be found in the 3D Scene module (see Section 2 3D Scene in Chapter 2 Setting Up a Show).

The properties of the virtual components included in the 3D Scene can be manipulated so they will perfectly match their physical counterparts. Notably, it is through the creation of these correlations that PHOTON is able to apply geometric corrections on a video feed to match the positioning and orientation of projectors and screens during a stage production.
This particular approach explains a lot about the software’s structure. In a PHOTON project, technical components coexist in different ways (physical and virtual), but also across different modules in the software. PHOTON Screens are a perfect example of this, in that they act as pivot points between different PHOTON modules and the stage space.

Screens simultaneously correspond to:

- physical screens in the stage space;
- virtual representations of the physical screens in the 3D Scene module;
- content assignation structures in the Timeline module.

Screens in the Timeline can hold many layers, where multiple media clips can be placed sequentially. Whenever a new Screen is created in the 3D Scene, it will create its own dedicated content assignation structure in the Timeline.

This impacts the way video content is produced, programmed and shown. Instead of working in one large video space that will be cut up for many projectors, you work directly on separate Screens. Placing a media file on the Timeline in a Screen will automatically display the file’s content on its physical counterpart.

### 2.4 Internal and External Data Exchange

PHOTON's parameters and their corresponding UI representations (such as sliders and number boxes) have been designed to support mapping internally (across the software) and externally.

Data sent from one point to another can be intercepted and changed using a mathematical function. For example, it could be rescaled for a new context.

Data can also be wrapped and sent through various protocols (UDP, PSN or MIDI) so they will be accepted by a wide variety of devices and software.

PHOTON's Mapping Manager module is dedicated to data exchange. Through a series of tables you will be able to map scaled data from UI components, an external keyboard, or MIDI and OSC devices directly to any other UI component (see Section 9 Mapping Manager in Chapter 4 Programming a Show).

UI components can also be linked to time-based markers and then animated through PHOTON's Keyframe Editor (see Section 8 Keyframe Editor in Chapter 4 Programming a Show).

PHOTON's FX Editor module can also be the place where you will connect data generated by a portion of the system to an effector situated elsewhere through a dataflow visual programming
Some of the FX Editor module building blocks can access the properties of objects created in the 3D Scene as well as tracking data generated by ALBION.

2.5 Metric System Only

The Metric System is the only system of measurement used in PHOTON. Each square of the 3D Scene grid is a square meter. To get accurate readings in the 3D Scene’s Projection Study mode, all of the 3D objects need to be declared in meters.

All of the readings the software provides, all of the transformations it performs and all of the data linked to stage automation will also be expressed using the Metric System.

VYV will never provide or accept translations to Imperial units of measurement because the Imperial system is considered obsolete by most authorities.

Note: The meter is the length of the path travelled by light in a vacuum during an interval of 1/299,792,458 of a second.

2.6 Real-Time Everywhere

PHOTON was built entirely on real-time processes. Since our product is mainly used for live multimedia productions, we focused on building a system that specializes in real-time delivery, and is able to adapt to on-the-spot changes that characterize this type of presentation.

Interactivity is at the very core of PHOTON, which makes it stand out amongst other media servers. All parameters are exposed and can be changed without any rendering time, making PHOTON an ideal tool when instantaneous action is required.

At VYV it is against our philosophy to limit the user in any way. This means there is no cap to the number of modules, media files and treatment processes a user can deploy in a PHOTON Project. However, this means it is the project programmer’s responsibility to ensure that the system’s frame rate does not drop below a specific threshold. (Depending on the circumstances, this could mean 60, 50, 30, 25 or 24 fps.)

2.7 Normalized Values

Most of the UI components in PHOTON, such as sliders, are normalized so their values range from 0. to 1.. We decided to normalize values in this way to facilitate data exchange between modules and data treatment using mathematical functions. One of the notable exceptions to this rule is the measurement of degrees, which range from 0. to 360..
2.8 UI Components Lexicon

A few terms describing UI components will be used regularly throughout PHOTON’s technical documents. Some of the terms might be self-explanatory; others have a meaning that is specific to PHOTON’s UI. We decided it would be best to provide definitions for all of them.

Module
A module denotes a structure in PHOTON dedicated to a group of similar tasks. For example, the I/O Module is dedicated to the exchange of data between PHOTON and external third-party devices. Along with the underlying methods, routines and behaviors dictated by the code’s structure, a module will always have its own window containing various widgets such as sliders, toggles, menus, and checkboxes that allow the user to modify parameters, launch tasks, etc.

- Modules can be accessed through the File, System and Show dropdown menus or through shortcuts beginning with the [Alt] key.

<table>
<thead>
<tr>
<th>File</th>
<th>System</th>
<th>Show</th>
<th>View</th>
<th>Hep</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td>Alt+S</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3D Scene</td>
<td>Alt+C</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I/O Manager</td>
<td>Alt+I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mapping Manager</td>
<td>Alt+N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Network Monitor</td>
<td>Alt+M</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shadow</td>
<td>Alt+Z</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto Import</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tools</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Window
A window is a rectangular frame that contains various widgets such as sliders, toggles, menus and checkboxes that will allow the user to modify parameters, launch tasks, etc. Windows can be divided in sections or can contain tabs.

- To select a window and focus on one of its components, [Left-Click] anywhere inside it. When selected, the window frame will turn red.
- To move the window around, [Alt+Click-Drag] inside the window.
- If you launched a module but the window does not seem to appear, press [F3]. PHOTON will redraw all windows.
- To minimize a window, left-click on the minus sign located at the top right corner of the window.
● To maximize a window, left-click on the plus sign located at the top right corner of the window.
● To close a window, left-click on the x sign located at the top right corner of the window.

Window Section
A window section is a subdivision of a window used to regroup widgets that are meant to work in conjunction with the execution of a task. For example: a list of clickable items and a button used to add items in the list would be located in the same window section. Window sections are generally preceded by a title and are delimited by a faded rectangular frame.
Some modules encompass more features than others. Windows tied to these modules will usually feature tabs: clickable components that facilitate switching between different panels. Panels accessible through tabs regroup coherent sets of widgets targeting a specific aspect of their module.

- Tabs located in the I/O Manager window feature a small pin icon.
- These tabs can be “unpinned” from the module’s window and displayed in an independent window by a [Left-Click] on the pin icon.
List

Lists are structured unidimensional sets of items. In PHOTON, the items contained in a list are identified by faded gray rectangles containing the item’s name or ID. The items usually support various interactions. They can be re-ordered through click-drag. A right-click on a list item will open a contextual menu offering various options.

Main Menu

Main menus are located at the very top of PHOTON’s main window (the black background that exists independently from the other modules). They either provide access to the software’s various modules or allow the user to perform operations like saving their current project.

Dropdown Menu

A dropdown menu appears as a white rectangular frame with a name or a currently selected option written in white. A downward or right pointing arrow will indicate that the menu is clickable and will provide the user with many options.
Contextual Menu

Contextual menus are activated by performing a right-click on a UI component such as an item in a list or a slider. Contents of a contextual menu will vary depending on the nature of the UI component affected by the right-click.

Slider

Sliders are either unidimensional or bidimensional widgets used to graphically and numerically represent the value set for a parameter. They are discussed in more detail later in this section of PHOTON's technical documents (see Section 2.11 Slider Types and Behaviors in Chapter 1 Prerequisites).

Toggle

A toggle is a widget that allows the user to set a parameter’s Boolean value (On/Off). Represented by a clickable rectangular frame, toggles are often used to indicate whether or not a particular option is activated. If an option is activated, the toggle’s rectangular frame will be highlighted.
**Button**

Buttons are widgets that can be clicked. They are used in various ways and their functions are represented by icons or names.

**Checkbox**

Checkboxes are used in conjunction with items in a list to indicate if they are selected to be inside or outside a set before applying an operation.

---

### 2.9 Renaming Labels

Most item labels can be renamed in PHOTON.

There are two methods for renaming labels:

- **Double-click** to put the slider in edit mode, which lets you type in the desired name; or,
- **Single-click** to focus on the item label and then press [F2] to put the slider in edit mode, which lets you type in the desired name.

---

### 2.10 Main Menu Bar

PHOTON's Main Menu Bar provides access to the software’s main modules. The modules are categorized based on their functions.
● Use the Main Menu Bar to gain access to the various modules that will allow you to build a PHOTON project.

2.11 Saving Methods

Saving in PHOTON may differ in some ways from what you might be accustomed to in other software. PHOTON’s Default Save {File > Save Default} writes in the main memory slot used for backing up a PHOTON Project’s files (using the .phd file extension).

● The Default Save is automatically loaded when PHOTON starts.

● The Default Save is automatically overwritten when PHOTON quits. A new save is created in the same memory slot, with the project’s current data.

Note: All types of Saves strictly include PHOTON’s data. None of the media files or 3D objects will be backed up through any of the saving methods.

● All saves will be located in ...VYV\photon\projects\current_project_name\config\...

● A PHOTON Save is divided into 3 files:
  ▪ a .phd file (PHOTON Data)
  ▪ a .io file (all the configurations of your input and output devices)
  ▪ a .uuc file (UI configurations; your current Workspace)

● There are 3 ways to save your PHOTON Project.
  ▪ Save Default [Ctrl+S]
  ▪ Save Incremental [Ctrl+Alt+S]
  ▪ Save Project... [Ctrl+Shift+S]

● We recommend you to save regularly and use all of the methods.
Save Default
PHOTON uses the Default Saves as its standard way of backing up your progress while working on a project.

- If you select {File > Save Default} or press [Ctrl+S] the current state of your project will overwrite the file that was previously saved as the Default Save. Therefore, Default Saves are destructive.

- By selecting {File > Load Default} or by pressing [Ctrl+L] you will revert your project to the previous state that was saved in the Default Save.

Furthermore, if you let PHOTON quit properly, by letting the Windows console finish its process, your project will automatically be saved as a Default Save. Note that the Default Save is also the save that will be loaded when PHOTON starts.

Load Default
1. Select {File > Load Default} or press [Ctrl+L] to load the version of the project currently saved in the Default Save memory slot. A Confirm Load Project dialog box will open and ask “Are you sure you want to reload the last default save?”
2. Click on the [Yes] button to reload the last default save. Click the [No] button if you decide to keep on working with your project in its current state.

Save Incremental
Save Incremental is the newest and fastest way to save. It incrementally creates new save files.

- By selecting {File > Save incremental} or by pressing [Ctrl+Alt+S] you will automatically create a saved project file without prompting a Windows file dialog.

The save will be named as follows:

```
Currentprojectname_yyyymmdd_hhmss
```

Example: Myproject_20180305_185423

Note: The date and time is determined by the local server’s operating system.

Save Project…
The Save Project command lets you save specially named versions of your project when it’s in a state that you want to keep as a backup.
• Selecting {File > Save Project...} or press [Ctrl+Shift+S] to prompt a Windows dialog that lets you name the project save.

Save Project is an inalterable step, a backup of your PHOTON Project’s data at a specific point, except if you manually delete it or choose to replace it.

Load Project
• Select {File > Load Project...} or press [Ctrl+Shift+L] to prompt a Windows file explorer that lets you access previous versions of your project created through any of the save methods.

• To load a previous version of your project, select the desired project file from Windows file explorer and click the [Open] button.

2.12 Slider Types and Behaviors
PHOTON uses three kinds of sliders depending on the type of data it needs to represent.

1D Slider
Allows you to control a large variety of parameters in the software. This UI component’s value can be modified by sliding the bar horizontally within the defined zone.

The 1D Slider can be edited in the following ways:
• Left-Click+Drag changes the value within the hardcoded range.
• [Ctrl+Left-Click+Drag] changes the value, with the option to exceed the hardcoded range.
• [Shift+Left-Click+Drag] changes the value within the hardcoded range at a slower pace to achieve more precision (10 times slower).
• [Ctrl+Shift+Left-Click+Drag] changes the value at a slower pace (100 times), with the option to exceed the hardcoded range.
• Double-Click puts the slider in edit mode and lets you type in the desired value.
• Single-Click to focus on the slider, followed by [F2] puts the slider in edit mode and lets you type in the desired value.

Note: Extended range and 100 times pace reduction only work with 1D Sliders.
**2D Slider**

Allows you to control a large variety of parameters in the software, such as size or position values. This UI component’s value can be modified by sliding the cross horizontally and vertically within the defined zone.

The 2D Slider can be edited in the following ways:
- Left-Click+Drag changes the value within the hardcoded range.
- [Shift+Left-Click+Drag] changes the value within the hardcoded range at a slower pace to achieve more precision (10 times slower).
- Double-Click puts the slider in edit mode and lets you type in the desired value.
- Single-Click to focus on the slider, followed by [F2] puts the slider in edit mode and lets you type in the desired value.
- [Tab] allows you to cycle your selection through the 2 values.

**Time Slider**

The Time Slider allows you to control timing parameters in the software by sliding the bar horizontally within the defined zone. For example, it will allow you to modify the In and Out of clips and media.

The Time Slider can be edited in the following ways:
- By clicking on the [In] button, you will set the current time of the Timeline’s Playhead to the Time Slider.
- Left-Click+Drag changes the value within the hardcoded range.
- [Shift+Left-Click+Drag] changes the value within the hardcoded range at a slower pace (10 times).
- Double-Click puts the slider in edit mode and lets you type in the desired value.
- Single-Click to focus on the Time Slider, followed by [F2] puts the slider in edit mode and lets you type in the desired value.
In edit mode, the Time Slider can be affected by using the basic (+) and (-) math commands.

- By inputting +n you will add n frames up to 99. For frames greater than 99., time will be segmented as hh:mm:ss:ff.
- By inputting -100 you will remove 1 second 00 frames.

```
-100
Out +2500
```

Note: The Time Slider is the only slider to show this behavior.
1. Settings

1.1 PHOTON Network

One of PHOTON’s great strengths is its ability to use networking technology to operate simultaneously and transparently on multiple servers controlled from a single unit. The first step in creating a Project is to establish a Server Group. Once servers are assigned in a group, PHOTON automatically creates a ring network to maintain communication between each server. Servers within in a group will share media content, maintain communication and sync together.

1.1.1 Server Group Creation

1. Select (System > Settings) from the main menu or press [Alt+S] to open the Settings module. Make sure the PHOTON tab is selected.

2. You will now establish a Server Group. Click on the network ring [pixbutton] button to open the Create Network Group window. A list located on the left side of the window will allow you to include or exclude servers from the group by checking or not checking their associated checkboxes.
If PHOTON has been launched on all of your servers, and if the servers reside on the same network (see Section 1.3 Network Configuration in Chapter 1 Prerequisites), they should appear in the Photon Selection servers list located on the left side of the Settings window (while the PHOTON tab is selected).

3. Select the servers you want in the group by checking the boxes next to their name. When selected, the servers will be identified by a green check mark.
4. Click on the [Apply] button to create a Server Group.
5. Once a Server Group is created, you should make sure the PHOTON Network is fully functional and that all of your servers are communicating properly.
6. Select {System > Network Monitor} from the main menu or press [Alt+M] to open the Network Monitor module. This module displays information about each server in the Server Group.

1.1.2 Removing Servers from a Server Group
1. Select {System > Settings} from the main menu or press [Alt+S] to open the Settings module. Make sure the PHOTON tab is selected.
2. Select the server you want to remove from your current group by clicking on its name in the PHOTON Selection servers list.
3. Click on the remove from network ring [pixbutton] button. A confirmation box window should appear in order to validate your selection. Click on the [OK] button if you still want to remove the server from the group.
4. Repeat this operation until all of the servers you want to remove are not in the list anymore.
5. Once a Server Group has been modified you should make sure the PHOTON Network is fully functional and that all of your servers are communicating properly.

6. Select {System > Network Monitor} from the main menu or press [Alt+M] to open the Network Monitor module. This module displays information about each server in your Server Group.

1.1.3 Remove and Shutdown PHOTON

1. This operation will remove a server from a group and shutdown PHOTON on the server. Select {System > Settings} from the main menu or press [Alt+S] to open the Settings module. Make sure the PHOTON tab is selected.

2. Select the server you want to remove from your current Server Group and shutdown by clicking on its name in the PHOTON Selection servers list.

3. Click on the ON/OFF [pixbutton] button. A confirmation box window should appear in order to validate your selection. Click on the [OK] button if you still want to remove the server and shutdown PHOTON.

4. Repeat this operation until all of the servers you want to remove are no longer in the Servers list.

5. Once a Server Group has been modified you should make sure the PHOTON Network is fully functional and that all of your servers are communicating properly.

6. Select {System > Network Monitor} from the main menu or press [Alt+M] to open the Network Monitor module. This module displays information about each server included in your Server Group.

1.1.4 Multiple Server Groups

Most projects will use a single Server Group. However, you might encounter situations where completely independent video installations co-exist within the same project. It is under these circumstances that multiple Server Groups should be considered.

1.1.5 Monitoring and Troubleshooting

Once a Server Group is created you should make sure the PHOTON Network is fully functional and that all of your servers are communicating properly.

- Select {System > Network Monitor} from the main menu or press [Alt+M] to open the Network Monitor module. This module displays information about each server in your Server Group.

The Network Monitor module provides feedback regarding resource usage (CPU, disk, RAM, VRAM), GPU performance (megabits per frame and temperature) and shows the project’s current frame rate output.
If a server is missing from the list, if its feedback cells are blank, or if the connection state cell shows a warning sign, it means communication problems are affecting the network. If such problems arise, you should check the following:

**Physical Network Connections**
Make sure the Ethernet cables are in good working order and are properly connected to the appropriate physical network interfaces.

**IP Addressing**
Make sure your servers coexist on the same network. Their IP addresses should share the same network prefix and subnet number (the first 3 octets in the IP address).

**Traffic Management**
Some network switches can filter out traffic, or a VLAN might have been set up on one of your servers. Make sure there is no interference of this kind on your network.

**Network Ports (within PHOTON)**
PHOTON uses specific network ports to synchronize data and transmit Show Control commands through a Server Group. Make sure the network ports on your servers match. On each server, select {Settings > Network tab} or press [Alt+S] and select the Network tab. The window will display the port numbers corresponding to Time Sync, Data Sync and Show Control. Each of these port numbers should be the same across your Server Group; with each port you should see the same number for Time Sync, Data Sync and Show Control. If the port numbers don’t match, you can reset them to Default by clicking on the [Reset] button or you can manually modify them by typing new values into their corresponding text boxes. If you change any of the port numbers, PHOTON will have to be restarted on all of the servers in the Server Group.

Once this problem is identified and corrected, the server’s state will automatically change in the Network Monitor.
1.1.6 Network Ports

PHOTON establishes Transmission Control Protocol (TCP) and User Data Protocol (UDP) communication between servers in a group order to allow multiple devices to act as a whole. Three different ports, each characterized by a specific function, are used by PHOTON:

**Time Sync Port**
This port is dedicated to PHOTON’s master clock. Current time (frame accurate) is sent from the primary server to the secondary servers so each device shares the same clock.

**Data Sync Port**
This port is dedicated to data exchange that corresponds to project structures, configurations and saves.

**Show Control Port**
This port is dedicated to show related commands such as cues. This port will be used by PHOTON to trigger events in the servers in the Server Group. This port might also be used by external devices or software for sending cues to PHOTON.

1.2 Server Operation Modes

PHOTON features different Operation Modes which represent the functions linked to the roles assigned to each server in the Server Group.
1.2.1 Hierarchy

A PHOTON Group is organized around a primary server which maintains synchronization and control over the remaining secondary servers. The primary server will also control or communicate with external devices such as projectors, lighting consoles or media matrices. Secondary servers are used to display images through their graphics card output ports.

If for any reason the primary server is dropped out of the Server Group and another server isn’t set up to take its place, the server with the lowest number IP address will take care of the group’s synchronization and control.

Even though a Server Group is driven by a central primary unit, a complete copy of the show’s data resides on every server. Therefore, each server acts like a backup unit (with one notable exception; see Controller and ALBION further on in this section).

1.2.2 Computer Vision

In addition to this hierarchical relationship, VYV’s product line includes ALBION, a server specialized in advanced computer vision tasks such as the handling of tracking data. This unique product is linked to a specific Operation Mode.

1.2.3 Operation Modes

Here are PHOTON’s Operation Modes:

Controller

The Controller is a primary server that controls secondary servers dedicated to media output. The Controller synchronizes the secondary servers and takes over their Timeline during show operations. If there is more than one Controller in the Server Group (this situation might arise if you have a backup unit), the secondary servers will be driven by the Controller that has the IP address with the smallest number. The Controller has access to external devices such as AV matrices and audio interfaces through its I/O Manager module. Low-resolution versions of the project’s media will be stored on the Controller because servers operating in this mode have to render content on all screens (Display Servers will only render content for screens that are visible to them). While a Controller does not feature any video output, its physical graphics outputs can be used to extend the UI on multiple screens. Using a Controller makes programming and operations significantly easier and is essential for stage productions.
Display
PHOTON Display Servers should be thought of as secondary units programmed and driven by a primary unit such as a Controller or a Display Master. While in Display mode, the server will store media at full resolution. Display Servers will only playback video content linked to screens that are assigned to its outputs in the 3D Scene Objects Visibility list (see Section 2.5 Projection Surfaces Visibility in Chapter 2 Setting Up a Show).

Display Master
The Display Master Server is a PHOTON Server mode that provides video content outputs while acting as a primary control unit at the same time. The Display Master mode should be viewed as a hybrid, combining aspects of the Controller and the Display Server modes. The Display Master Server will synchronize and control the Display Servers located on the network and will have access to other external devices such as AV matrices and audio interfaces through its I/O Manager module. The Display Master Server will also import and convert media in full resolution and will be able to output content for the screens that have been assigned to it. While it would be tempting to see this mode as a practical replacement for a Controller, keep in mind that using a Display Master Server comes with drawbacks related to overall system performance. Primary servers set in Display Master mode are usually found in simple installations, not large scale productions.

Albion
This mode specifically relates to servers that are dedicated to tracking data generation, treatment and transmission. These tasks include network camera stream acquisition and analysis, and the broadcast of the PosiStageNet (PSN) protocol. ALBION Servers do not provide video outputs and cannot import media (with the exception of 3D Models because they can be used for tracking). Therefore, ALBION Servers cannot act as a backup units. While a Controller can act as an ALBION Server, it is not recommended because the handling of synchronization and Show Control data might interfere with the smoothness of the tracking.
NOTE: A Display 4K System Mode can also be accessed in the dropdown menu. It was created to support video output in quadrants as a way to adapt to early 4K video interfaces. It is now obsolete because all outputs on NVIDIA Quadro graphics cards can be set at 4K resolution.

1.3 Camera Attribution and Server Modes

Cameras are used by PHOTON to track optical markers and to perform real-time projector alignment and auto-calibration. OptiTrack cameras (the brand supported by VYV) can only be connected to one server at a time. You will have to decide how you want cameras to be accessed by the servers.

Select {System > Settings} from the main menu or press [Alt+S] to open the Settings module.

Click on the Control tab to access the {Albion Control} dropdown menu and the {Auto Calib Control} dropdown menu. This is where you will link cameras to specific servers.

Depending on the type of set up you have, there are 3 possible scenarios for camera attribution:
Camera Segregation

You might have 2 independent camera networks. One would be dedicated to tracking, the other to calibration. This can be done through VLANs or physically segregated networks. Make sure that the Controller and the ALBION Servers are each connected to the right camera network. Using the dropdown menus, select the dedicated ALBION Server underneath Albion Control and the dedicated Controller Server underneath Auto Calib Control. This type of set up is rarely deployed since, under most circumstances, cameras used during calibration can be easily re-assigned and can reinforce tracking when they are in the same group.

Sequential Access

You might have a single network where all of the cameras reside. If you are planning to use all of the cameras for both functions — tracking and calibration — you will need to manually change how they are assigned depending on which task is currently done. Before making changes you will have to calibrate the system. Using the dropdown menus, select the dedicated Controller Server for both Albion Control and Auto Calib Control. Once the calibration process is complete, you will have to select the ALBION dedicated server in both dropdown menus.

Albion and Controller Running on the Same Server

If you have a single camera network and plan to use the same server for both tracking and calibration, you will still have to let PHOTON know which server is linked to cameras. Using the dropdown menus, select the Controller Server for both Albion Control and Auto Calib Control.

1.4 I/O Control Attribution and Server Modes

Once Server Modes have been attributed to devices, you will have to determine which server has access to the I/O Control Interfaces that facilitate information exchange with external devices. These interfaces are presented as tabs in the I/O Manager module: Art-Net, Network Protocol, Audio Analysis, Projector Devices and Matrix Switcher.

1. Select {System > I/O Manager} or press [Alt+I] to open the I/O Manager window so you can monitor the state of the I/O Control Interfaces listed above.
2. Select {System > Settings} or press [Alt+S] and click on the Control tab to access the I/O Control dropdown menu.
3. If the menu is set to “default-”, the I/O Control Interfaces can be accessed by the server identified as a Controller. You can also access the I/O Control Interfaces by going to the dropdown menu and selecting a specific device from the Server Group. It is also
possible to select the “-inactive-” option from the dropdown menu to cease all communications with external devices.

1.5 Windowing for the User Interface (UI) and the Video Outputs

By default, a new PHOTON Project will automatically activate the Auto Window Creation and Draw Canvas View options on your servers. These options will affect windowing for the UI and the video outputs.

Select {System > Settings} or press [Alt+S] and click on the PHOTON tab to access both options, represented by toggles in the right side of the window.

1.5.1 Auto Window Creation

This option (activated by default) forces PHOTON to automatically create video output windows through its graphic output cards. If you previously created a Mosaic display group using the NVIDIA driver (which is recommended by VYV for better performance), you have to disable this option.
1. Select the first server that features a Mosaic display group by clicking on its name in the PHOTON Selection servers list.
2. Click on the [Auto Window Creation] toggle to deactivate the option (the toggle will fade).
3. Repeat this operation with all devices in the Server Group that feature a Mosaic display group.

1.5.2 Draw Canvas View

By default, PHOTON Servers always use the first video output on their graphics card to display their UI. The server’s Operation Mode has no effect on this. (A Display Server or a Display Master Server will feature the same behavior.) If you wish to use this first output to display video content (which could turn a Display Server from a 3 or 7 video output device to a 4 or 8 video output device), you will have to deactivate Draw Canvas View on all of the targeted servers.

1. Select the first server that you want to strip of its UI by clicking on its name in the PHOTON Selection servers list.
2. Click on the Draw Canvas View toggle to deactivate the option (the toggle will fade).

Note: Keep in mind that even if you added a video output, the UI will still be accessible and will overlay the first output.

1.5.3 Hide/Show the User Interface Locally

● Press the [Tab] key to turn the UI on or off, using the server that has keyboard control.

1.5.4 Hide/Show the User Interface Remotely

● Select {System > Settings} or press [Alt+S] and click on the General tab, under UI Options. [Hide/Show Network UI] buttons will hide/show the interface remotely on all Display Servers and Display Master Servers. (A server set in Controller mode will ignore this command.)

1.6 Virtual Video Output Creation

Once the Operation Mode and the proper windowing attributes have been applied to all devices in the Server Group, you will have to create your PHOTON Project’s video outputs. These virtual video outputs are the virtual counterparts of the physical outputs on the servers’ graphics
cards. They are associated with video media delivery and should be connected to a physical display device such as a video projector, LED processor or video monitor.

### 1.6.1 Virtual Video Output

1. Select {System > Settings} or press [Alt+S] and click on the PHOTON tab to access the Outputs window section.
2. Go to the PHOTON Selection servers list and select the first server that will be used to display video by clicking on its name (it will be a Display Server or a Display Master Server).
3. Once the server is selected you can add the virtual video outputs to it by clicking on the [+] button in the Outputs window section.

Whenever a new virtual video output is created, a confirmation box window will appear asking if you want to create a projector in the 3D Scene and link it to this output. The physical video display devices connected to your outputs are represented in a virtual space called the 3D Scene, which corresponds to the real-life stage where your PHOTON Project will be presented.

Note: The term “Projectors” applies to a wide variety of video displays, with the only exception being LED processors, which are represented by a different type of structure.
4. If you are starting your PHOTON Project from scratch, you should accept the creation of new Projectors so your 3D Scene will already be populated. Click on the [Yes] button to do so.

- There are a few cases where you might want to add virtual video outputs without automatically creating projectors in the 3D Scene. Such cases would be the following:
  - video outputs are connected to LED processors; or,
  - projectors will be imported from another Project; or,
  - the current Project is built over a Projection Study and already has projectors in the 3D scene.

If these conditions apply to you, simply click on the [No] button and repeat this operation with every server in the PHOTON Selection servers list.

**Virtual Video Output Resolution for Display Servers and Display Master Servers**

Once all of the outputs have been created and correctly assigned, you have to set the resolution for each one.
1. The Settings window should already be open and the PHOTON tab selected. If not, select (System > Settings) or press [Alt+S] and click on the PHOTON tab to access the Outputs window section.

2. If you didn’t create a Mosaic display group (see Section 1.6 Graphic Card Mosaic Configuration in Chapter 1 Prerequisites) and left the Auto Window Creation toggle enabled, which is not recommended, (see Article 1.5.1 Auto Window Creation in Chapter 2 Setting Up a Show), you should be able to select the Output Resolution dropdown menu and Controller Resolution drop-down menu.

3. Select a Display Server by clicking on its name in the PHOTON Selection servers list. Select an output on the server by clicking on its name in the Outputs list.

4. Select the appropriate resolution (the one that matches the resolution of your Mosaic display group) from the Output Resolution dropdown menu and the Controller Resolution dropdown menu.

**Video Outputs Resolution for Controllers**

Since Controllers do not feature video outputs dedicated to media playback, these servers will only allow you to select a resolution from the Controller Resolution dropdown menu.

The Settings window should already be open and the PHOTON tab selected. If not, select (System > Settings) or press [Alt+S] and click on the PHOTON tab to access the Outputs window section.

Select the Controller Server by clicking on its name in the PHOTON Selection servers list. Select the appropriate resolution (the one that matches the resolution of your Mosaic display group) from the Controller Resolution dropdown menu.

**1.6.2 Signal Routing Validation through Display Ident**

Once the virtual video outputs have been created, you should make sure that the signal routing and the projector assignation are correct.

1. Select {System > 3D Scene} from the main menu or press [Alt+C] to open the 3D Scene module.

2. Select the calibration mode by using the toggle at the top right of the window or press the [4] key (with the 3D Scene in focus).

3. Open the Options panel by clicking on the Settings [pixbutton] button.

4. Enable the [Display Ident] toggle.

5. This option will display a random solid color on all video outputs. Each generated image also features an inverted color border, 4 pulsating VYV logos, as well as the name of the
output and the projector assigned to it. This will allow you to make sure the signal routing is OK.

Note: Display Idents are rendered on top of everything and there is no automatic mechanism to disable them. Make sure you disable Display Idents manually when you are done with the signal routing testing procedure.
1.6.3 Virtual Video Output Assignation Dropdown Menus

Each of the virtual video outputs listed in the Outputs window section has an Assignation dropdown menu next to it. This dropdown menu links the virtual video output to a representation in the 3D Scene.

- If Projectors were automatically created while creating video outputs, the virtual video outputs listed in the dropdown menus will reflect the fact that they are already linked.
- If you want to set the assignation of a video output to a corresponding 3D Scene virtual display, use the dropdown menu to select the desired virtual output Primitive.

1.6.4 Video Output Assignation and Backup Servers

If your Server Group includes a device dedicated to being a Display Server or Display Master Server backup unit, you should plan ahead, and automate switches in projector attribution in order to seamlessly recuperate the outputs driven by the failing server. The following steps should be complemented by Video Matrix cue recording (see Section 5.8 Video Matrix Control in Chapter 2 Setting Up a Show)

1. Select the backup unit by clicking on its name in the PHOTON Selection servers list.
2. Create the first virtual video output for your backup unit by pressing on the [+] button in the Outputs window section.
3. When prompted by the confirmation box window to create a Projector in the 3D Scene, click on [No].
4. Create as many virtual video outputs on the backup unit as there are on your typical Display Server.
5. Record a cue with all of your virtual video outputs set to {no output}. (See Section 1.1 Cue Recording in Chapter 4 Programming a Show.)
6. Record a cue with all of your virtual video outputs set to the Projectors linked to the first Display Server you want to use as a backup in case of failure. (See Section 1.1 Cue Recording in Chapter 4 Programming a Show.)
7. Repeat the previous step with the remaining Display Servers.
2. 3D Scene

The 3D Scene module is used for integrating video outputs (such as projectors), video inputs (such as cameras), screen surfaces and stage automation devices in a virtual representation of the real-world stage space. It is through manipulations of this virtual stage space (the 3D Scene) that operations such as camera calibration, screen surfaces tracking, projection calibration and blending will be made possible.

Note: Tasks and operations described in this section of the manual mainly have to do with the binding between the real-world stage space and the virtual stage space as it is represented in PHOTON. Naturally, if you want to see actual results in the real world, Displays (such as video projectors or monitors) must be connected to the Video Output Ports, and you have to declare all of your project’s Virtual Video Outputs in the Settings module (see Section 1.6 Virtual Video Outputs Creation in Chapter 2 Setting Up a Show).

2.0.1 3D Scene Lexicon

Throughout this section of PHOTON’s technical documents the following terms are regularly used:

**Displays**
Displays are any kind of device used for displaying video signals, such as video projectors, video monitors, LED walls, etc.

**Signal Transmission**
Signal transmission refers to the act of sending a video signal point-to-point from a Video Output Port (a graphic card’s physical output) to a device used for display, such as a video projector or monitor. Signal transmission is usually accomplished through cable distribution (fiber, HD-SDI, Ethernet, etc.).

**Video Output Ports**
Video Output Ports are the physical connectors attached to the graphic cards that are installed in the servers used to output video signal.

**Virtual Video Outputs**
PHOTON uses Virtual Video Outputs as a way to represent the Video Output Ports. Virtual Video Outputs have to be declared in the Outputs list located in the Photon tab of the Settings module window (see Section 1.6 Virtual Video Outputs Creation in Chapter 2 Setting Up a Show).
Virtual Displays

Virtual Displays are the virtual counterparts of the tangible, real-world displays described in this lexicon. Some types of Virtual Displays, such as Projectors, can be automatically created when Virtual Video Outputs are first declared.

Screens

PHOTON’s structure is based on real and virtual screens. All screens used as displays in the physical world have a virtual counterpart in the 3D Scene module, which acts as a simulation of the stage (or exhibition) space. Each real-world screen will have to be represented by a virtual one, which in turn will be linked to one or more video outputs. In the 3D Scene module, Screens act as a virtual representation of the Projection Surfaces. They are also represented in the Timeline module, where you can assign layers of media clips to them.

Video Content

The term “video content” refers to the still images and video files that are imported into PHOTON, mapped as a texture onto Screens, and eventually played back using the Timeline module.

Calibration

Calibration designates a process through which geometric coordinates are established between elements in the virtual scene and their real-world counterparts. By aligning the geometric features shared by a real screen surface and its model, PHOTON can reconstruct the position and orientation of displays as a means of mapping video content onto physical objects and other structural elements of the real-world stage. Many processes taking place during calibration are handled automatically by PHOTON. For example, edge blending between video outputs can be calculated dynamically in real time without user intervention. The system also automatically differentiates between cases where 2D or 3D transformations are applied, based on the geometric characteristics of the screen’s surface. PHOTON supports many approaches to calibration; some involve manual operations, and others are automated and rely on data provided via the analysis of camera feeds.

Blending

Blending designates a process through which the projected images of multiple projectors are altered and seamlessly blend into one another, creating an uninterrupted surface (see Section 2.8 Blending in Chapter 4 Programming a Show).
2.1 Signal Routing and Display Identification

Before starting a calibration process, you should always validate signal paths and make sure the various video displays (monitors, projectors, etc.) are correctly identified. Beyond the obvious problems caused by broken signal paths, incorrect video output identification might lead to confusion during the calibration process.

Note: Before activating Display Identification, make sure all of your Displays are powered and properly connected to the Video Output Ports on all servers. Also make sure you have declared all of your Virtual Video Outputs in the Settings module (see Section 1.6 Virtual Video Outputs Creation in Chapter 2 Setting Up a Show). Otherwise, PHOTON will not output video content.

2.1.1 Signal Routing

In order to send video content to a display, the following path must be followed:

- Media > Screens > Virtual Display > Virtual Output > Graphic Card Physical Output > Signal Transmission > Display

If the signal does not reach the Display, you should test the signal path in the order described above.

2.1.2 Display Identification

PHOTON features an identification card system designed to simplify troubleshooting operations related to display identification and signal path continuity.

PHOTON can simultaneously generate random-colored identification cards featuring output names and corresponding display names for each declared Virtual Video Output. (Note that animated VYV logos and an output name are integrated in each identification card.)
Sending identification cards simultaneously through every output will allow you to visually validate the signal path and the output configuration (and naming).

Enable Display Ident

Before enabling Display Ident you should have integrated your Display Servers and Display Master Servers into your Server Group, and declared all of their Outputs in the Settings module (see Section 1.1.1 Server Group Creation in Chapter 2 Setting Up a Show and Section 1.6 Virtual Video Outputs Creation in Chapter 2 Setting Up a Show). Doing so will allow you to see the identification cards in your Displays.

1. Open the File Manager module by pressing [Alt+C] or by selecting {System > 3D Scene}.
3. Open the Settings Panel by clicking on the gear icon button.
4. Click on the [Display Ident] toggle to activate Display Ident.

Note: Identification cards will be rendered on top of everything, and will therefore hide calibration and display rendering. Make sure Display Ident is off when you are done with it.
2.2 Adding Projection Surfaces

Projection Surfaces need to be added in the 3D Scene in order to create Screens that will be made visible for Virtual Displays (see Section 2.5 Projection Surfaces Visibility in Chapter 2 Setting Up a Show). When Screens are paired with Virtual Displays they can be calibrated with their real-life counterparts. Screens will also co-exist in the Timeline module, where they hold layers of video content.

Projection Surfaces are virtual 3D objects that formally correspond to their real-life counterparts; they make it possible for a wall (onto which video content is projected) to be represented by a rectangular plane, or the surface of a planetarium to be represented by a hemisphere, etc.

PHOTON features a library of Default Objects from which you can pick and choose. This library contains commonly used Projection Surfaces (sphere, cube, rectangular plane, etc.). It is also possible to import custom-made 3D objects in PHOTON in order to represent complex Projection Surfaces such as theatrical props and set elements (see Section 2.1 Import 3D Objects in Chapter 3 Importing Content).

Add a Projection Surface

1. Open the File Manager module by pressing [Alt+C] or by selecting {System > 3D Scene}.
3. Select a Default Object through {Primitive > Default Objects > one of the objects listed in the Default Objects library} or a custom 3D model through {Primitive > XSI or OBJ or FBX}.

Once selected, the new Projection Surface will appear in the 3D Scene as an entry in the Scene Primitives list. It will also appear in the 3D Scene Preview.
2.3 Manual 2D Keystone Calibration

Once signal paths have been tested and Displays properly identified (see Section 2.1 Signal Routing and Display Identification in Chapter 2 Setting Up a Show), it is time to calibrate outputs.

Manual 2D keystone calibration is the simplest form of calibration offered in PHOTON. It should be used in cases where video content is projected onto flat surfaces or displayed on video monitors. By manipulating the four corners of a Screen within a Virtual Display, the user can position them in relation to the four corners of a Display (corner-pin). This method can also be used to correct the trapezoidal distortion of an image caused by a difference in angle between the alignment of a real-world projector and projection surface (keystone correction).

2.3.1 Add a Projector in the 3D Scene

In order to start the calibration process, you will need a virtual representation of the real-world display. If you are attempting a manual keystone calibration, the appropriate Virtual Display type is a Projector (even if you are attempting to calibrate a video monitor such as a TV).

Make sure the Virtual Video Output that corresponds to the Video Output Port was declared in the Settings module when you created your project’s Network Group. If this wasn’t done, please do so before continuing (see Section 1.6 Virtual Video Outputs Creation in Chapter 2 Setting Up a Show).
Automatic Projector Creation

When a Virtual Video Output is declared in the Settings module, a confirmation box opens and displays the following message: “Do you want to create a Projector in the 3D Scene and link it to this output?” By clicking the [Yes] button you will automatically add a Projector in the 3D Scene linked to the new output.

Manual Projector Creation

If for any reason you created a Virtual Video Output but did not assign a Projector to it, you will have to follow these steps:

1. In the 3D Scene module, select {Primitive > Display > Projector} to create a new Projector. A new entry (named Projector) will appear in the Scene Primitives list. A pyramid, representing the light beam emitted by the Projector, will also be visible in the 3D Scene Preview.

2. In the Settings module, go to the Photon Selection list and select the server you want to use as an output for the video signal.
3. Beside each of the Virtual Video Outputs you created, you will find a dropdown menu with the {no output} option selected. Using the dropdown menu linked to the appropriate Virtual Video Output, select the Projector you created.

Renaming a Projector

Once a Projector in the 3D Scene is linked to a Virtual Video Output, you can rename it to make it easier to identify. (In complex projects involving many Displays, renaming Projectors is a must-do.)

- [Double-click] on the Projector's entry in the Scene Primitives list. A text field will appear allowing you to enter a new name for the Projector.
2.3.2 Add a Plane in the 3D Scene

For a manual 2D calibration the Projection Surface is necessarily a plane. This plane can represent a video monitor (a TV screen, for example) or a wall upon which video content will be projected.

- To add a plane to the 3D Scene, select {Primitive > Default Objects > Plane} in the Primitive dropdown menu.

The plane will appear in the Scene Primitives list, and a visual representation of it will appear at the origin (0,0,0) of the 3D Scene Preview.

Note: Many ready-to-use 3D objects are available in PHOTON. They can act as Projection Surfaces and simplify the construction of the virtual representation of your real-world stage space. 3D objects can be selected from the Primitive dropdown menu {Primitive > Default Objects}.

2.3.3 Scale, Translate and Rotate the Plane

It is possible to modify the shape of the plane in order to match the ratio of the real-world display it represents. You can also position and rotate the plane in space to match the position and orientation of the real-world display.

Why Apply 3D Transformations?

Scaling, positioning and orienting are crucial in stage contexts where many real-world projectors cover many Screen Surfaces. Under these circumstances, it is important to accurately represent the spatial relations between all objects in PHOTON’s virtual world. If the spatial relations between objects aren’t accurately represented it won’t be possible to complete the calibration process.
 Scaling, positioning and orienting are not crucial in stage contexts involving single Displays linked to single Screen Surfaces that act as autonomous pairs. However, doing so is considered a best practice and will give you access to a realistic pre-visualization of the project.

Note: Project pre-visualization is one of PHOTON’s key features. VYV’s software can create full 3D simulations of the real-world stage space. In the 3D Scene module Screen Surfaces (with their video content), Displays, cameras, lighting equipment, and set elements can be placed in a virtual space that provides a complete overview of a project.

Applying the 3D Transformations
An object’s size, position or orientation (Decorative Objects as well as Projection Surfaces) in the 3D Scene can be modified using the Transformations Panel or Transformation Manipulators.

Transformations Panel
The Transformations Panel contains multiple sliders that allow the modification of the Scale, Translate and Rotate parameters for each axis (X, Y and Z) for any object previously created in the 3D Scene module.

- Select the object you want to alter by clicking on its entry in the Scene Primitives list.
- To open the Transformations Panel, press [T] on the keyboard or select {Window > Transformation} in the 3D Scene’s main menu.
- To change the geometric coordinates of an object, adjust the value of the sliders. You can adjust the value of a slider by manipulating it with a [Click+Drag], or you can [Double-click] on it to open a text field where you can enter a desired numeric value.
The effects of these transformations can be seen in the 3D Scene Preview. The graphic representation of the selected object will be modified as well.

Note: Slider values differ depending on the parameters they represent. The Scale sliders are not dimension sliders; they act as scaling coefficients applied to the object’s original size. For example, if the scale value of a cube featuring edges of 2 meters is changed from 1 to 4 on all three axes, the cube will now have edges of 8 meters. The Translate sliders express a value in meters. The Rotate sliders express values in angles. And the Rotate Axis sliders are used to apply a rotation expressed in an angle that corresponds to specific vectors. For example, an angle is set with the first slider while the three other sliders represent vector values for each axis that will determine how the rotation will be applied to each.
Transformation Manipulators

The Transformation Manipulators facilitate direct modification of a 3D object's parameters —Scale, Translate, Rotate — by manipulating your mouse in the 3D Scene Preview.

Enable the desired Transformations Manipulator using the following methods:

- **Scale Manipulator**: Press [X] on the keyboard or click on the Scale button located in the top-right corner of the 3D Scene window.
- **Translate Manipulator**: Press [V] on the keyboard or click on the Translate button located in the top-right corner of the 3D Scene window.
- **Rotate Manipulator**: Press [C] on the keyboard or click on the Rotate button located in the top-right corner of the 3D Scene window.

The Transformation Manipulators will appear when a 3D object is selected.

PHOTON’s Manipulators feature a standard color-scheme for its 3D coordinate system: X is red, Y is green and Z is blue.

- [Click+Drag] the handle of the axis parameter you want to modify (X, Y or Z). The handle will become yellow when selected.
- The Scale and Translate Manipulators feature a yellow dot at the intersection of their axes. [Click+Drag] the yellow dot to simultaneously apply transformations to all axes.
Note: Enabling a Manipulator will disable camera movements in the 3D Scene Preview. To switch back to camera control, press [S] on the keyboard or click the Camera button located at the top-right corner of the 3D Scene.

Note: If you want to control the camera while a Manipulator is enabled, press and hold [S] on the keyboard. This will allow you to manipulate the camera. To switch back to Manipulator control, release the [S] key.

### 2.3.4 Freeze Transformations

Freezing an object’s Transformations sets its current size, orientation and location as the new default values without modifying the object’s geometric coordinates.

#### Freeze an Object

- Select the object by clicking on its entry in the Scene Primitives list.
- To activate the Transformations Panel press [T] on the keyboard or select {Window > Transformation} in the 3D Scene main menu.
- Click on the [Set Freeze] button located at the top of the Transformations Panel.
- If you want to revert to the object’s initial parameters, you can unfreeze it by clicking on the [Reset Freeze] button located at the top of the Transformations Panel.

#### Why Freeze?

Freezing an object sets its Calibration Points directly in relation to its new position in the 3D Scene Preview. Calibration Points are created out of a 3D object’s vertices and are the main features used during the calibration process. Therefore, it is crucial to alert the software through the [Set Freeze] command if a 3D object’s geometric parameters have been modified before starting the calibration process.

Furthermore, 3D objects in PHOTON can be linked to position and orientation data (provided by stage automation and tracking or animations). These 3D objects will move in the real world but you will want to retain their original geometric data for the purposes
of display calibration. Freezing makes this possible, and facilitates accurate projection on surfaces that move.

2.3.5 Map the Plane to the Display

Once the plane that acts as the Projection Surface has undergone the appropriate geometric transformations and has been frozen, you have to add it to the Objects Reference list.

In order to calibrate a Display (find its position and orientation in the real world), PHOTON has to build geometric correspondences with at least one 3D object representing a physical structure in the real world. In this case, the plane will act both as a Projection Surface and a Reference Object.

1. Select the 3D Scene module’s Calibration mode by pressing [4] or by clicking on the [Calibration] button located at the top-right corner of the 3D Scene window.

Once the Calibration mode is enabled, the 3D Scene Preview will turn red and the Calibration Tools Window will open in the lower right part of the 3D Scene window.

2. Select the Display you want to calibrate by clicking on its entry in the Calibration Tools Window list. (If you haven’t renamed the Display, it will be listed as “Projector.”)

Make sure the Display Grid is enabled. By showing a representation of how the Display’s texture map is distributed (both in the 3D Scene Preview and in the real-world projection) the Display Grid will let you preview the amount of distortion affecting the projected image. Normally, you will try to limit distortion as much as possible by manipulating the Calibration Points.

3. Press [D] or click on the gear icon button to access the 3D Scene module’s Settings menu and click on the [Display Grid] toggle if the Display Grid isn’t already activated.

4. In the Primitive Preset window section (below the Calibration Tools Window), select the plane from the {Object Reference} dropdown menu.

5. Click on the [Add] button to add the plane as a Reference Object. Also, notice that the plane was automatically added to the Objects Visibility list (see Section 2.5 Projection Surfaces Visibility in Chapter 2 Setting Up a Show).

The plane will be covered by green dots corresponding to its vertices in the 3D Scene Preview.
Note: You will notice that a single item named “Manual” initially populates the Objects Reference list. Adding a new object as the plane to the Objects Reference list eliminates the item named “Manual.” The “Manual” item refers to the fact that if a Display does not have a Reference Object, it can still be positioned and oriented manually using your mouse in the Calibration Tools Window Preview. Hover the mouse on the preview and use the mouse scroll wheel for positioning on the Z-axis, Right-click+Drag for positioning on the X- and Y-axes, and Left-click+Drag to orient the Display.

Note: Multiple 3D objects can be added as Reference Objects for the same Display. This allows the Display to simultaneously support multiple calibrations. For example, in a case where a single video projector covers two different Screen Surfaces, each Screen Surface would be represented by a 3D object, and both 3D objects would have to be added as Reference Objects to the same Display (representing the video projector).

Note: A single 3D object can be added as a Reference Object for multiple Displays. For example, in a situation where beams of light from multiple projectors fall on a single Projection Surface, the same 3D object (corresponding to the Projection Surface) would have to be added to each of the Displays (corresponding to the video projectors).

### 2.3.6 Calibration Point Creation and Manipulation

In order to calibrate the Display, you will have to create four Calibration Points that match the four corners of the plane. You will then manipulate these Calibration Points until the image being displayed isn't distorted.
**Calibration Point Creation**

Calibrations Points are created by converting vertices: the green dots that correspond to the 3D object’s vertices. This is done through a [Ctrl+Double-click] applied to a vertex.

To perform a manual 2D keystone calibration, you will have to create Calibration Points using the four corners of the plane.

- [Ctrl+Double-click] sequentially on the four vertices that match the four corners of the plane.

Whenever a vertex point is converted to a Calibration Point and is selected, it will double in size and turn white. An unselected Calibration Point will retain this double size but will turn blue.

Once the four Calibration Points have been created, the plane displayed in the Calibration Tools Window will snap to its four corners and completely fill its space.

If you want to use the full pixel space offered by the Display and there isn’t a need for any kind of geometric correction (if you plan to output the signal to a video monitor, for example), you are done.

**Calibration Points, Crosses and Lines**

Whenever a Calibration Point is created, a green cross will appear in the Calibration Tools Window Preview where it is positioned. The green cross will also be projected by the Display it is linked to. If the Calibration Point is moved, the cross will also move to reflect the change of position.

If the Calibration Point is selected, its corresponding green cross will feature elongated white lines that will extend until they reach the edge of the projected image.
These two features — green crosses and white lines — should help you calibrate the Display. Parameters for both the crosses and the lines are accessible in the Options menu. If you want to modify these parameters, click on the gear icon button to access the Options Panel and manipulate the following widgets:

- **Display Cross toggle**: [Click] on the toggle to show/hide the green crosses.
- **Display Lines toggle**: [Click] on the toggle to show/hide the white lines.
- **2D Point Size slider**: [Click+Drag] the slider to change the size of the green crosses.
- **Line Width slider**: [Click+Drag] the slider to change the width of the white lines.

### Manipulating Calibration Points

If you have to apply 2D geometric corrections (such as keystoning) to the video output, you will have to manipulate the Calibration Points. By moving Calibration Points in PHOTON you will alter the projected image’s geometric coordinates and compensate for alignment differences between a Projector and its related Projection Surface.

Calibration Points will have to be selected and moved one by one from those that were previously declared. This step has to be repeated with each of the previously declared Calibration Points (a keystone correction will involve four Calibration Points). The final positions of the Calibration Points in the projected image (on the real-world Projection Surface) will make it possible to project an accurate (geometrically correct) image.

Calibration Points can be manipulated by using the keyboard on its own, or by using a combination of the mouse and keyboard.

#### Keyboard Calibration Point Manipulations

**Select Previous/Next Calibration Point**
- [Page Up] selects the next Calibration Point.
- [Page Down] selects the previous Calibration Point.

**Move the Calibration Point that is Currently Selected**
- [Arrows] move the selected Calibration Point in any of the four directions represented by the arrows keys.
- [Shift+Arrows] applies the same effect as above, only 10 times slower.
- [Ctrl+Shift+Arrows] applies the same effect as above, only 100 times slower.

**Move the Entire Calibration**
- [Alt+Arrows] moves all of the Calibration Points at the same time.
- [Alt+Shift+Arrows] applies the same effect as above, only 10 times slower.

**Add/Remove a Calibration Point**
- [-] removes the Calibration Point that is currently selected.
- [+] adds a new Calibration Point corresponding to the vertex that is currently selected, or re-adds a previously deleted Calibration Point.

---

**Mouse and Keyboard Calibration Point Manipulations**

**Select a Calibration Point from the Calibration Tools Window Preview**
- [Ctrl+Left-click] selects the Calibration Point that is closest to your cursor and moves it to where you have clicked.

**Select a Calibration Point in the 3D Scene Preview**
- [Ctrl+Left-click] on a Calibration Point (blue dots) to select it (it will turn white).

**Cycle Through Calibration Point Selection**
- [Mouse wheel]: Place the mouse over the Calibration Tools Window Preview and use the mouse wheel to cycle through the previously declared Calibration Points.

**Move a Calibration Point**
- [Left-click] anywhere in the Calibration Tools Window Preview to move the selected Calibration Point to its new location.
- [Left-click+Drag] anywhere in the Calibration Tools Window Preview to move the selected Calibration Point in the direction that you drag the mouse.
- [Shift+Left-click+Drag] applies the same effect as above, only 10 times slower.
Add/Remove a Calibration Point

- [Ctrl+Double-click] on a vertex (green dots) on the Reference Object in the 3D Scene Preview to create a new Calibration Point.
- [Ctrl+Right-click] on a Calibration Point to remove it.

2.4 Manual 3D Calibration

The manual calibration process for a 3D projection surface (for example, a cube) is only slightly different from the one described in section 2.3 Manual 2D Keystone Calibration. The main difference resides in the number of Calibration Points needed by PHOTON to achieve a geometric match between the real-world projector and projection surface with their virtual counterparts. If a 3D object is selected for calibration and a sufficient quantity of well-distributed Calibration Points are identified on its surface (with regard to width, height and depth), PHOTON will automatically perform a 3D calibration. There is no need to specify if a calibration is tridimensional or bidimensional.

- A **minimum of six Calibration Points** will be needed to calibrate a projector for a 3D object. These Calibration Points correspond to some of the vertices of the 3D object acting as the Projection Surface.

The vertices selected for the calibration should be distributed along the 3D object’s three axes (X, Y and Z) in order to convey enough information about its volume and surface to PHOTON. For example, selecting all of the Calibration Points on the same surface of a 3D object will prevent the software from performing tridimensional calibration since coplanar vertices do not carry information about the 3D object’s volume.

- A **maximum of nine Calibration Points** should be used when calibrating a 3D object. Using more Calibration Points is possible, but it might lead to an accumulation of small positioning errors, which will have a detrimental effect on the calibration.

2.4.1 Add a Projector in the 3D Scene

In order to start the calibration process, you will need a virtual representation of the real-world display. If you are attempting a manual 3D calibration, the appropriate Virtual Display type is a Projector.

Make sure the Virtual Video Output that corresponds to the Video Output Port was declared in the Settings module when you created your project’s Network Group. If this wasn’t done, please do so before continuing (see Section 1.6 Virtual Video Outputs Creation in Chapter 2 Setting Up a Show).
Automatic Projector Creation

When a Virtual Video Output is declared in the Settings module, a confirmation box opens and displays the following message: "Do you want to create a Projector in the 3D Scene and link it to this output?" By clicking the [Yes] button you will automatically add a Projector in the 3D Scene linked to the new output.

Manual Projector Creation

If for any reason you created a Virtual Video Output but did not assign a Projector to it, you will have to follow these steps:

- In the 3D Scene module, select {Primitive > Display > Projector} to create a new Projector. A new entry (named Projector) will appear in the Scene Primitives list.

A pyramid, representing the light beam emitted by the Projector, will also be visible in the 3D Scene Preview.

- In the Settings module, go to the Photon Selection list and select the server you want to use as an output for the video signal.
• Beside each of the Virtual Video Outputs you created, you will find a dropdown menu with the {no output} option selected. Using the dropdown menu linked to the appropriate Virtual Video Output, select the Projector you created.

Renaming a Projector

Once a Projector in the 3D Scene is linked to a Virtual Video Output, you can rename it to make it easier to identify. (In complex projects involving many Displays, renaming Projectors is a must-do.)

• Double-click on the Projector’s entry in the Scene Primitives list. A text field will appear allowing you to enter a new name for the Projector.
2.4.2 Add a 3D Object in the 3D Scene

For a manual 3D calibration the Projection Surface is necessarily a 3D object. This 3D object can represent a prop or the surface of a tridimensional set element onto which video will be projected. The 3D object can either be selected from the ready-made Default Objects in the Primitive dropdown menu or it can be a custom made model (.obj, .fbx or .xsi) imported through the File Manager module. The following subsections will use the cube corner model (listed as a {Cube}) from the Default Objects as an example.

- To add a 3D object to the 3D Scene, select {Primitive > Default Objects > Cube} in the Primitive dropdown menu.

![3D Scene](image)

The cube corner will appear in the Scene Primitives list, and a visual representation of it will appear at the origin (0,0,0) of the 3D Scene Preview.

Note: Many ready-to-use 3D objects are available in PHOTON. They can act as Projection Surfaces and simplify the construction of the virtual representation of your real-world stage space. 3D objects can be selected from the Primitive dropdown menu {Primitive > Default Objects}.

2.4.3 Scale, Translate and Rotate the 3D Object

It is possible to modify the shape of the cube corner in order to match the ratio of the real-world prop it represents. You can also position and rotate the cube corner in space to match the position and orientation of the real-world prop.
**Why Apply 3D Transformations?**

Scaling, positioning and orienting are crucial in stage contexts where many real-world projectors cover many Screen Surfaces. Under these circumstances, it is important to accurately represent the spatial relations between all objects in PHOTON’s virtual world. If the spatial relations between objects aren’t accurately represented it won’t be possible to complete the calibration process.

Scaling, positioning and orienting are not crucial in stage contexts involving single Displays linked to single Screen Surfaces that act as autonomous pairs. However, doing so is considered a best practice and will give you access to a realistic pre-visualization of the project.

*Note: Project pre-visualization is one of PHOTON’s key features. VYV’s software can create full 3D simulations of the real-world stage space. In the 3D Scene module Screen Surfaces (with their video content), Displays, cameras, lighting equipment, and set elements can be placed in a virtual space that provides a complete overview of a project.*

**Applying 3D Transformations**

An object’s size, position or orientation (Decorative Objects as well as Projection Surfaces) in the 3D Scene can be modified using the Transformations Panel or Transformation Manipulators.

**Transformations Panel**

The Transformations Panel contains multiple sliders that allow the modification of the Scale, Translate and Rotate parameters for each axis (X, Y and Z) for any object previously created in the 3D Scene module.

- Select the object you want to alter by clicking on its entry in the Scene Primitives list.
- To open the Transformations Panel, press [T] on the keyboard or select {Window > Transformation} in the 3D Scene’s main menu.
To change the geometric coordinates of an object, adjust the value of the sliders. You can adjust the value of a slider by manipulating it with a [Click+Drag], or you can [Double-click] on it to open a text field where you can enter a desired numeric value.

![Image of Transformations panel]

The effects of these transformations can be seen in the 3D Scene Preview. The graphic representation of the selected object will be modified as well.

Note: Slider values differ depending on the parameters they represent. The Scale sliders are not dimension sliders; they act as scaling coefficients applied to the object's original size. For example, if the scale value of a cube featuring edges of 2 meters is changed from 1 to 4 on all three axes, the cube will now have edges of 8 meters. The Translate sliders express a value in meters. The Rotate sliders express values in angles. And the Rotate Axis sliders are used to apply a rotation expressed in an angle that corresponds to specific vectors. For example, an
angle is set with the first slider while the three other sliders represent vector values for each axis that will determine how the rotation will be applied to each.

**Transformation Manipulators**

The Transformation Manipulators facilitate direct modification of a 3D object’s parameters—Scale, Translate, Rotate—by manipulating your mouse in the 3D Scene Preview.

Enable the desired Transformations Manipulator using the following methods:

- **Scale Manipulator:** Press [X] on the keyboard or click on the Scale button located in the top-right corner of the 3D Scene window.
- **Translate Manipulator:** Press [V] on the keyboard or click on the Translate button located in the top-right corner of the 3D Scene window.
- **Rotate Manipulator:** Press [C] on the keyboard or click on the Rotate button located in the top-right corner of the 3D Scene window.

The Transformation Manipulators will appear when a 3D object is selected.

PHOTON’s Manipulators feature a standard color-scheme for its 3D coordinate system: X is red, Y is green and Z is blue.

- [Click+Drag] the handle of the axis parameter you want to modify (X, Y or Z). The handle will become yellow when selected.
- The Scale and Translate Manipulators feature a yellow dot at the intersection of their axes. [Click+Drag] the yellow dot to simultaneously apply transformations to all axes.

Note: Enabling a Manipulator will disable camera movements in the 3D Scene Preview. To switch back to camera control, press [S] on the keyboard or click the Camera button located at the top-right corner of the 3D Scene.
Note: If you want to control the camera while a Manipulator is enabled, press and hold \[S\] on the keyboard. This will allow you to manipulate the camera. To switch back to Manipulator control, release the \[S\] key.

2.4.4 Freeze Transformations

Freezing an object’s Transformations sets its current size, orientation and location as the new default values without modifying the object’s geometric coordinates.

**Freeze an Object**

- Select the object by clicking on its entry in the Scene Primitives list.
- To activate the Transformations Panel press \[T\] on the keyboard or select {Window > Transformation} in the 3D Scene main menu.
- Click on the [Set Freeze] button located at the top of the Transformations Panel.
- If you want to revert to the object’s initial parameters, you can unfreeze it by clicking on the [Reset Freeze] button located at the top of the Transformations Panel.

**Why Freeze?**

Freezing an object sets its Calibration Points directly in relation to its new position in the 3D Scene Preview. Calibration Points are created out of a 3D object’s vertices and are the main features used during the calibration process. Therefore, it is crucial to alert the software through the [Set Freeze] command if a 3D object’s geometric parameters have been modified before starting the calibration process.

Furthermore, 3D objects in PHOTON can be linked to position and orientation data (provided by stage automation and tracking or animations). These 3D objects will move in the real world but you will want to retain their original geometric data for the purposes of display calibration. Freezing makes this possible, and facilitates accurate projection on surfaces that move.
2.4.5 Map the 3D Object to the Display

Once the cube corner that acts as the Projection Surface has undergone the appropriate geometric transformations and has been frozen, you have to add it to the Objects Reference list.

In order to calibrate a Display (find its position and orientation in the real world), PHOTON has to build geometric correspondences with at least one 3D object representing a physical structure in the real world. In this case, the cube corner will act both as a Projection Surface and a Reference Object.

1. Select the 3D Scene module’s Calibration mode by pressing [4] or by clicking on the [Calibration] button located at the top-right corner of the 3D Scene window.

Once the Calibration mode is enabled, the 3D Scene Preview will turn red and the Calibration Tools Window will open in the lower right part of the 3D Scene window.

2. Select the Display you want to calibrate by clicking on its entry in the Calibration Tools Window list. (If you haven’t renamed the Display, it will be listed as “Projector.”)
Make sure the Display Grid is enabled. By showing a representation of how the Display’s texture map is distributed (both in the 3D Scene Preview and in the real-world projection) the Display Grid will let you preview the amount of distortion affecting the projected image. Normally, you will try to limit distortion as much as possible by manipulating the Calibration Points.

3. Press [D] or click on the gear icon button to access the 3D Scene module’s Settings menu and click on the [Display Grid] toggle if the Display Grid isn’t already activated.

4. In the Primitive Preset window section (below the Calibration Tools Window), select the {Cube} (which is in fact a cube corner) from the {Object Reference} dropdown menu.

5. Click on the [Add] button to add the cube corner as a Reference Object. Also, notice that the cube corner was automatically added to the Objects Visibility
list (see Section 2.5 Projection Surfaces Visibility in Chapter 2 Setting Up a Show).

The cube corner will be covered by green dots corresponding to its vertices in the 3D Scene Preview.

Note: You will notice that a single item named “Manual” initially populates the Objects Reference list. Adding a new object as the cube corner to the Objects Reference list eliminates the item named “Manual.” The “Manual” item refers to the fact that if a Display does not have a Reference Object, it can still be positioned and oriented manually using your mouse in the Calibration Tools Window Preview. Hover the mouse on the preview and use the mouse scroll wheel for positioning on the Z-axis; [Right-click+Drag] for positioning on the X- and Y-axes; and [Left-click+Drag] to orient the Display.

Note: Multiple 3D objects can be added as Reference Objects for the same Display. This allows the Display to simultaneously support multiple calibrations. For example, in a case where a single video projector covers two different Screen Surfaces, both Screen Surfaces
would be represented by its own 3D object, and both 3D objects would have to be added as Reference Objects to the same Display (representing the video projector).

Note: A single 3D object can be added as a Reference Object for multiple Displays. For example, in a situation where beams of light from multiple projectors fall on a single Projection Surface, the same 3D object (corresponding to the Projection Surface) would have to be added to each of the Displays (corresponding to the video projectors).

2.4.6 Calibration Point Creation and Manipulation

In order to calibrate the Display, you will have to create seven Calibration Points that match the corners of the cube corner. You will then manipulate these Calibration Points until the image being displayed isn’t distorted. (You can use the corner created by the junction of two straight walls and a floor to simulate an open cube if you don’t have access to such a prop.)

Calibration Point Creation

Calibrations Points are created by converting vertices: the green dots that correspond to the 3D object’s vertices. This is done through a [Ctrl+Double-click] applied to a vertex.

To perform a manual 3D calibration, you will have to create Calibration Points using the seven corners of the cube corner.

- [Ctrl+Double-click] sequentially on the seven vertices that match the seven corners of the cube corner.

Whenever a vertex point is converted to a Calibration Point and is selected, it will double in size and turn white. An unselected Calibration Point will retain this doubling of size but will turn blue.

When you create a Calibration Point, move it to its new position before creating another one. Follow the remaining instructions to learn how to manipulate the Calibration Points.
Calibration Points, Crosses and Lines

Whenever a Calibration Point is created, a green cross will appear in the Calibration Tools Window Preview where it is positioned. The green cross will also be projected by the Display it is linked to. If the Calibration Point is moved, the cross will also move to reflect the change of position.

If the Calibration Point is selected, its corresponding green cross will feature elongated white lines that will extend until they reach the edge of the projected image.

These two features — green crosses and white lines — should help you calibrate the Display. Parameters for both the crosses and the lines are accessible in the Options menu. If you want to modify these parameters, click on the gear icon button to access the Options Panel and manipulate the following widgets:

- **Display Cross toggle**: Click on the toggle to show/hide the green crosses.
- **Display Lines toggle**: Click on the toggle to show/hide the white lines.
- **2D Point Size slider**: [Click+Drag] the slider to change the size of the green crosses.
- **Line Width slider**: [Click+Drag] the slider to change the width of the white lines.
Manipulating Calibration Points

If you have to apply 3D geometric corrections to the video output, you will have to manipulate the Calibration Points. By moving Calibration Points in PHOTON you will alter the projected image’s geometric coordinates and compensate for alignment differences between a Projector and its corresponding Projection Surface.

Calibration Points will have to be selected and moved one by one. This step has to be repeated with each of the declared Calibration Points. The final positions of the Calibration Points in the projected image (on the real-world Projection Surface) will make it possible to project an accurate (geometrically correct) image.

Calibration Points can be manipulated by using the keyboard on its own, or by using a combination of the mouse and keyboard.

Keyboard Calibration Point Manipulations

Select Previous/Next Calibration Point
- [Page Up] selects the next Calibration Point.
- [Page Down] selects the previous Calibration Point.

Move the Calibration Point that is Currently Selected
• [Arrows] move the selected Calibration Point in any of the four directions represented by the arrows keys.
• [Shift+Arrows] applies the same effect as above, only 10 times slower.
• [Ctrl+Shift+Arrows] applies the same effect as above, only 100 times slower.

**Move the Entire Calibration**
• [Alt+Arrows] moves all of the Calibration Points at the same time.
• [Alt+Shift+Arrows] applies the same effect as above, only 10 times slower.

**Add/Remove a Calibration Point**
• [-] removes the Calibration Point that is currently selected.
• [+] adds a new Calibration Point corresponding to the vertex that is currently selected, or re-adds a previously deleted Calibration Point.

---

**Mouse and Keyboard Calibration Point Manipulations**

**Select a Calibration Point from the Calibration Tools Window Preview**
• [Ctrl+Left-click] selects the Calibration Point that is closest to your cursor and moves it to where you have clicked.

**Select a Calibration Point in the 3D Scene Preview**
• [Ctrl+Left-click] on a Calibration Point (blue dots) to select it (it will turn white).

**Cycle Through Calibration Point Selection**
• [Mouse wheel]: Place the mouse over the Calibration Tools Window Preview and use the mouse wheel to cycle through the previously declared Calibration Points.

**Move a Calibration Point**
• [Left-click] anywhere in the Calibration Tools Window Preview to move the selected Calibration Point to its new location.
• [Left-click+Drag] anywhere in the Calibration Tools Window Preview to move the selected Calibration Point in the direction that you drag the mouse.
• [Shift+Left-click+Drag] applies the same effect as above, only 10 times slower.

**Add/Remove a Calibration Point**
● [Ctrl+Double-click] on a vertex (green dots) on the Reference Object in the 3D Scene Preview to create a new Calibration Point.
● [Ctrl+Right-click] on a Calibration Point to remove it.

2.5 Projection Surfaces Visibility

Projection Surfaces have to be made visible for specific Displays in the 3D Scene before video content can be projected onto them.

A 3D object that was not made visible to a Display will still exist in the 3D Scene and the Timeline but will not have the ability to display content and will not act as a Projection Surface. Also, a 3D object can be made visible for some Displays while remaining invisible to others, therefore acting as a Projection Surface for specific video projectors.

Controlling the visibility of a 3D object for individual Displays is useful in contexts where multiple video projectors and screens coexist in the same space. Assigning the visibility of a Screen to specific Displays will ensure that the projected video content will not appear on other unintended surfaces. Also, specifying which Display sees which Screen helps a lot when optimizing a project — eliminating unnecessary Screens from the Visibility lists of selected Displays reduces the load on the servers. In some cases, 3D objects can be used to calibrate Displays but will not be used as Projection Surfaces.

Note: The calibration processes described in sections 2.3 Manual 2D Keystone Calibration and 2.4 Manual 3D Calibration both feature a single 3D object mapped to a Display. When the 3D objects were added to the Objects Reference list, they were also automatically added to the Objects Visibility list.

Adding a Projection Surface to the Objects Visibility List

If a 3D object is added to the Objects Reference list (see Section 2.3.5 Map the Plane to the Display in Chapter 2 Setting Up a Show), it will automatically appear in the Objects Visibility list because this behavior covers the most common set up (a 3D object corresponding to a Screen is calibrated and will show video content).

If you want to manually add a Projection Surface to the Objects Visibility list, follow these steps:

1. Make sure the 3D Scene module is open (by pressing [Alt+C] or by selecting {System > 3D Scene} from the Main menu) and that it is currently set in the Calibration mode (by pressing [4] or by clicking on the [Calibration] button).
2. You should have already created the Display (see Section 2.3.1 Add a Projector in the 3D Scene in Chapter 2 Setting Up a Show) and the 3D object
that will act as the Projection Surface (see Section 2.3.4 Add a Plane in the 3D Scene).

3. Select the Display for which you want to make the Projection Surface visible by clicking on its entry in the Calibration Tools Window list.

4. Select the 3D object corresponding to the Projection Surface you want to make visible for the currently selected Display from the dropdown menu located in the Objects Visibility window section.

Removing a Projection Surface from the Objects Visibility List

Follow these steps if you want to remove a 3D object previously declared as a Projection Surface from a Display’s Objects Visibility list:

1. Make sure the 3D Scene module is open (by pressing [Alt+C] or by selecting {System > 3D Scene} from the Main menu) and that it is currently set in the Calibration mode (by pressing [4] or by clicking on the [Calibration] button).

2. Select the Display for which you want to make the Projection Surface invisible by clicking on its entry in the Calibration Tools Window list.
3. Use your mouse to rollover the Projection Surface’s entry in the Objects Visibility list and click on the “X” symbol to remove it.

Blanking a Projection Surface from the Objects Visibility List

You might want to temporarily remove a Projection Surface entry from the Objects Visibility list without permanently deleting it. This is called “blanking” and is akin to temporarily muting a video channel linked to a Display and a Projection Surface.

1. Make sure the 3D Scene module is open (by pressing [Alt+C] or by selecting {System > 3D Scene} from the Main menu) and that it is currently set in the Calibration mode (by pressing [4] or by clicking on the [Calibration] button).
2. Select the Display for which you want to make the Projection Surface invisible by clicking on its entry in the Calibration Tools Window list.
3. Click on the [b] button next to the Projection Surface’s entry in the Objects Visibility list you want to blank. If you wish to “unblank” the Projection Surface, click on the “no entry” symbol that replaced the [b] button.

2.6 Convergence and Seamless Projection

The calibration processes described in sections 2.3 Manual 2D Keystone Calibration and 2.4 Manual 3D Calibration involved a single Display and a single Projection Surface functioning as an autonomous pair. However, in many situations, multiple projectors will aim at the same
Projection Surface. This might be done to create seamless video coverage over the surface of a large screen or over a surface that wraps around a tridimensional structure. Multiple video projectors can also be stacked and aimed at the same screen to increase its luminosity. Both cases imply small changes to the calibration procedures and are explained below.

### 2.6.1 Convergence

Convergence occurs when multiple projectors are stacked and are aiming at the same Projection Surface. Convergent calibrations can be tricky to achieve because the projected image will be blurred if the geometrical corrections applied to each Display are not perfect.

To successfully apply a convergent calibration, make sure to follow these guidelines:

- Use the same 3D object as the Reference Object for all Displays (in this case, the video projectors aimed at the same surface).
- The 3D object acting as a Screen should also be made visible for each of the Displays.
- Displays should share Calibration Points. Sharing some of the same Calibration Points will ensure that the Displays are properly aligned. The two most common examples are:
  - In a situation where two video projectors are aimed at the same area on a wall, the same four Calibration Points corresponding to the Screen’s four corners should be used for both Displays.
  - In a situation where two video projectors are aimed at a tridimensional structure acting as a Screen, Calibration Points placed in the intersection of the video projectors’ beams should be shared by both Displays.
- Press [D] on the keyboard or click on the gear icon button to access the 3D Scene module’s Settings menu and click on the [Display Grid] toggle if the Display Grid isn’t already activated. Once activated, the Display Grid will help you align Displays because the pattern it projects onto Screens exaggerates the blurriness generated by a bad calibration.

### 2.6.2 Seamless Projection

In stage productions that rely on video mapping, coverage is often intended to span seamlessly across large surfaces. In some cases, large surfaces call for a very high pixel count, which can only be achieved by using multiple video projectors. To create the illusion of a seamless video image on a large surface follow these guidelines:

- Video projector beams should cover the whole Projection Surface.
- The beams of contiguous video projectors should intersect to create overlapping projection areas. These overlapping projection areas should amount to 15% of a Display’s total projection area.
- Intersecting video projectors should share Calibration Points in their shared projection area.
- Press [D] on the keyboard or click on the gear icon button to access the 3D Scene module’s Settings menu and click on the [Display Grid] toggle if the Display Grid isn’t already activated. Once activated, the Display Grid will help you align Displays since the pattern it projects onto Screens exaggerates the blurriness generated by a bad calibration in the shared projection area.

2.7 Display Soloing

When the Calibration mode is enabled, all of the Displays that are connected will simultaneously project/show Display Grids or the 3D object meshes. This can be overwhelming and might create confusion while attempting calibration.

To simplify the calibration process it is possible to select a single Display out of the group and mask the output of the other Displays.

Solo a Display

In the Calibration Tools Window Display list, [Right-click] on the entry corresponding to the Display you want to solo. A contextual menu will open.
Select {Solo} from the contextual menu. You will notice that the Eye icons located to the right of each entry in the Calibration Tools Window Display list will feature a strikethrough, except for the Display that was calibrated solo.

If you wish to "unsolo" the Display, repeat the same action.

Note: The solo function will remember which Display you have masked (or not) when you "unsolo."

2.8 Default Camera Selection

The 3D Scene Preview features a Default Camera through which you can see the virtual stage space. This Default Camera has a fixed visual field and is not represented.

If you want to visualize the virtual stage space with a different visual field or use a Display’s or Camera Object’s point of view, you can change how the Default Camera is assigned. For example, you could use a Display such as a video projector to act as the Default Camera, to
see what lies in front of it. (This is a good way to verify if a Projection Surface is in a Projector’s visual field). You can also use this feature to verify if video cameras are aiming in the right direction.

A dropdown menu located in the top-left corner of the 3D Scene window will allow you to change the Default Camera’s attributes.

Click on the {Default Camera} dropdown menu and select the Camera, Display or Virtual Projector you want to use as the 3D Scene Preview’s new point of view.

Note: If you select a Camera as the new point of view and move it around in the 3D Scene, you will modify its parameters.

Note: You can select calibrated Projectors and Cameras as points of view, but you will not be able to move them or change any of their parameters because the Calibration process locks their position and orientation.

### 2.9 Blending

Multiple projectors are often used to create a seamless video image on a Projection Surface. For calibrating multiple projectors PHOTON features automatic edge blending, a process through which the projected images are altered to seamlessly blend into one another.

PHOTON automatically calculates Blending masks when a user is calibrating. The only decision a user has to make is to determine whether the Blending is static (once the Calibration process is complete Blending masks are saved and applied to the video outputs) or done in real-time (the Blending is calculated every frame — which is useful if Screens or Video Projectors are moving during the show).

**Enable Blending and Select Blending Mode**

Make sure the 3D Scene module’s current mode is not set to [Modeling]. Access to the Blending Panel is not possible when [Modeling] is selected.
1. To open the Blending Panel, click on the [B] button located in the top-right corner or the 3D Scene window.
2. Click the [Enable] toggle to activate Blending.

<table>
<thead>
<tr>
<th>Blending Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>p-space 3.5 (RT GPU)</strong></td>
<td>RT GPU stands for Real-Time Graphics Processing Unit. This Blending mode uses the Server's graphic card (the GPU) to calculate Blending masks for every frame (hence, in real-time). p-space 3.5 (RT GPU) should be selected when a project involves moving Projection Surfaces or moving Video Projectors. This is the most demanding Blending mode and should be used concurrently with Blending Channels to reduce the load on the servers.</td>
</tr>
<tr>
<td><strong>p-space 3.5 (static)</strong></td>
<td>This Blending mode uses the same algorithm as the p-space 3.5 (RT GPU) but it is only computed once (not in real-time). Therefore, this Blending mode should be used when dealing with static Projection Surfaces and Video Projectors. It is the least demanding Blending mode and is useful when projecting on very large static structures (which usually involves very large video files). If p-space 3.5 (static) is selected, a [Compute Mask] button will appear. The Blending mask will be calculated every time you click on this button, making it possible for you to recalculate masks if there are changes in the Calibration.</td>
</tr>
<tr>
<td><strong>p-space 3.4 (GPU)</strong></td>
<td>This Blending mode is legacy. (It is kept in the software to support older projects.) It is outdated and should not be used.</td>
</tr>
</tbody>
</table>
2.10 Calibration Lock

Once a Calibration is complete, it is possible to lock it in order to avoid unintended modifications (for example, accidently clicking in the Calibration Tools Window Preview could void a perfect Calibration if it isn’t locked).

Locking a Calibration
1. Press [4] on the keyboard or click on the [Calibration] toggle to select the 3D Scene module’s Calibration mode.
2. Click the Calibration Lock button located in the top-right corner of the Calibration Tool window.

Locking All Calibrations
1. Access the Settings Panel by clicking on the Settings button.
2. Click on the [Controls Locked] toggle to lock all Calibrations.
Note: [Controls Locked] will lock Calibration for all Displays. Following this, it will be impossible to add new Calibration Points, manually move Displays (for both position and orientation) or attempt Auto-Calibration.

2.11 Apply 3D Transformations to Objects and Freeze

2.11.1 Scale, Translate and Rotate a 3D Object

It is possible to modify the shape of a 3D object in order to match the ratio of the real-world prop, set element, screen structure, etc. it represents. You can also position and rotate the 3D object in space to match the position and orientation of the real-world prop.

Why Apply 3D Transformations?
Scaling, positioning and orienting are crucial in stage contexts where many real-world projectors cover many Screen Surfaces. Under these circumstances, it is important to accurately represent the spatial relations between all objects in PHOTON’s virtual world. If the spatial relations between objects aren’t accurately represented it won’t be possible to complete the calibration process.

Scaling, positioning and orienting are not crucial in stage contexts involving single Displays linked to single Screen Surfaces that act as autonomous pairs. However, doing so is considered a best practice and will give you access to a realistic pre-visualization of the project.

Note: Project pre-visualization is one of PHOTON’s key features. VYV’s software can create full 3D simulations of the real-world stage space. In the 3D Scene module Screen Surfaces (with their video content), Displays, cameras, lighting equipment, and set elements can be placed in a virtual space that provides a complete overview of a project.

Applying 3D Transformations
An object’s size, position or orientation (Decorative Objects as well as Projection Surfaces) in the 3D Scene can be modified using the Transformations Panel or Transformation Manipulators.

Transformations Panel
The Transformations Panel contains multiple sliders that allow the modification of the Scale, Translate and Rotate parameters for each axis (X, Y and Z) for any object previously created in the 3D Scene module.
• Select the object you want to alter by clicking on its entry in the Scene Primitives list.

• To open the Transformations Panel, press [T] on the keyboard or select {Window > Transformation} in the 3D Scene’s main menu.

• To change the geometric coordinates of an object, adjust the value of the sliders. You can adjust the value of a slider by manipulating it with a [Click+Drag], or you can [Double-click] on it to open a text field where you can enter a desired numeric value.

The effects of these transformations can be seen in the 3D Scene Preview. The visual representation of the selected object will be modified as well.

Note: Slider values differ depending on the parameters they represent. The Scale sliders are not dimension sliders; they act as scaling coefficients applied to the object’s original size. For example, if the scale value of a cube featuring edges of 2 meters is changed from 1 to 4 on all three axes, the cube will now have edges of 8 meters. The Translate sliders express a value in meters. The Rotate sliders express values in angles. And the Rotate Axis sliders are used to apply a rotation expressed in an angle that corresponds to specific vectors. For example, an angle is set with the first slider while the three other sliders represent vector values for each axis that will determine how the rotation will be applied to each.

Transformation Manipulators

The Transformation Manipulators facilitate direct modification of a 3D object’s parameters —Scale, Translate, Rotate — by manipulating your mouse in the 3D Scene Preview.

Enable the desired Transformations Manipulator using the following methods:

• **Scale Manipulator**: Press [X] on the keyboard or click on the Scale button located in the top-right corner of the 3D Scene window.

• **Translate Manipulator**: Press [V] on the keyboard or click on the Translate button located in the top-right corner of the 3D Scene window.

• **Rotate Manipulator**: Press [C] on the keyboard or click on the Rotate button located in the top-right corner of the 3D Scene window.

The Transformation Manipulators will appear when a 3D object is selected.
PHOTON’s Manipulators feature a standard color-scheme for its 3D coordinate system: X is red, Y is green and Z is blue.

- [Click+Drag] the handle of the axis parameter you want to modify (X, Y or Z). The handle will become yellow when selected.

- The Scale and Translate Manipulators feature a yellow dot at the intersection of their axes. [Click+Drag] the yellow dot to simultaneously apply transformations to all axes.

Note: Enabling a Manipulator will disable camera movements in the 3D Scene Preview. To switch back to camera control, press [S] on the keyboard or click the Camera button located at the top-right corner of the 3D Scene.

Note: If you want to control the camera while a Manipulator is enabled, press and hold [S] on the keyboard. This will allow you to manipulate the camera. To switch back to Manipulator control, release the [S] key.

2.11.2 Freeze Transformations

Freezing an object’s Transformations sets its current size, orientation and location as the new default values without modifying the object’s geometric coordinates.

Freeze an Object

- Select the object by clicking on its entry in the Scene Primitives list.

- To activate the Transformations Panel press [T] on the keyboard or select {Window > Transformation} in the 3D Scene main menu.

- Click on the [Set Freeze] button located at the top of the Transformations Panel.

- If you want to revert to the object’s initial parameters, you can unfreeze it by clicking on the [Reset Freeze] button located at the top of the Transformations Panel.

Why Freeze?

Freezing an object sets its Calibration Points directly in relation to its new position in the 3D Scene Preview. Calibration Points are created out of a 3D object’s vertices and are the main features used during the calibration process. Therefore, it is crucial to alert the
software through the [Set Freeze] command if a 3D object’s geometric parameters have been modified before starting the calibration process.

Furthermore, 3D objects in PHOTON can be linked to position and orientation data (provided by stage automation and tracking or animations). These 3D objects will move in the real world but you will want to retain their original geometric data for the purposes of display calibration. Freezing makes this possible, and facilitates accurate projection on surfaces that move.

### 2.12 Decorative Objects

In the 3D Scene it is possible to add 3D objects that do not act as Screens. These 3D objects can be used to represent technical equipment, set elements, seating, etc. that are part of the real-world stage space, without being used as Projection Surfaces.

PHOTON’s default behavior is to consider any 3D object added in the 3D Scene module as a Screen. As a result, these 3D objects end up being represented in the Timeline module, which might create confusion.

It is possible to declare 3D objects as Decorative Objects to prevent PHOTON from automatically turning them into Screens. As Decorative Objects these 3D objects will not be shown in the Timeline module, and will be taken into account for computations related to video projection.

#### Declaring a Decorative Object

1. Select the 3D object by clicking on its entry in the Scene Primitives list.
2. Press [P] on the keyboard or select {Window > Properties} from the 3D Scene module’s menu to open the Properties Panel.
3. Click on the first dropdown menu in the {Display Options} section of the Properties Panel to change the default option from {Projection Surface} to {Decorative}. 
2.13 LED Screen Calibration

LED Screens are not calibrated in the same way that Projectors are. There are many differences between the instructions for LED Screen calibration and those listed in Section 2.3 Manual 2D Keystone Calibration and Section 2.4 Manual 3D Calibration.

The main differences between these approaches are the following:

**Display Type**

LED Screens use the LED Processor Display type instead of Projectors. Unlike Projectors, LED Processors are not automatically offered as a default Display when a new video output is declared in the Settings module. LED Processors have to be created in the 3D Scene module and then linked back to the appropriate video output. They are the only other Display type that can be linked to a video output.
Calibration Tools Window Interface

If an LED Processor Display is selected in the Calibration Tools Window list, the Calibration Tools Window interface will change and offer a new set of options that are appropriate for LED Screens.

Calibration Technique

LED Processor Displays use quads (cells featuring a quadrilateral shape) to segment, resize and position video content in a virtual 2D space. The resulting visual composition is then outputted to the real-world LED Processors connected to the LED walls. This approach facilitates content mapping for these devices.

2.13.1 Add an LED Processor

The first step is to add an LED Processor Display in the 3D Scene module. If the project you are working on features many real-world LED Processors, you will have to add an LED Processor Display for each of them.

1. Make sure the 3D Scene module is open (by pressing [Alt+C] or by selecting {System > 3D Scene} from the Main menu).
2. Select {Primitive > Display > LED Processor} from the Primitive dropdown menu.

The LED Processor will appear at the bottom of the Scene Primitives list.

Note: The LED Processor Display is not represented in the 3D Scene Preview.

2.13.2 Add a Primitive

While LED Screens are not Projection Surfaces, they still need to be represented by a 3D object. The shape of the 3D object should match the shape of the real-world LED Screen.
The selected 3D object is often a plane because LED Screens tend to have a rectangular format.

- To add a 3D object to the 3D Scene, select {Primitive > Default Objects > any of the objects listed here} in the Primitive dropdown menu.

The 3D object will appear in the Scene Primitives list, and a visual representation of it will appear at the origin (0,0,0) of the 3D Scene Preview.

Note: Many ready-to-use 3D objects are available in PHOTON. Referred to as Default Objects, they simplify the construction of the virtual representation of your real-world stage space. Default Objects can be selected from the Primitive dropdown menu {Primitive > Default Objects}. 
2.13.3 Scale, Move, Rotate the 3D Object

It is possible to modify the shape of the 3D object in order to match the ratio of the real-world LED Display it represents. You can also position and rotate the 3D object in space to match the position and orientation of the real-world LED Display. Since the calibration process for LED Displays relies strictly on 2D texture mapping (LED Displays are not Projection Surfaces), scaling, positioning and orienting are not crucial. However, doing so is considered a best practice and will give you access to a realistic pre-visualization of the project.

Note: Project pre-visualization is one of PHOTON’s key features. VYV’s software can create full 3D simulations of the real-world stage space.

Applying the Transformations

A 3D object’s size, position or orientation in the 3D Scene can be modified using the Transformations Panel or Transformation Manipulators.

Transformations Panel

The Transformations Panel contains multiple sliders that allow the modification of the Scale, Translate and Rotate parameters for each axis (X, Y and Z) for any object previously created in the 3D Scene module.

- Select the object you want to alter by clicking on its entry in the Scene Primitives list.
- To open the Transformations Panel, press [T] on the keyboard or select {Window > Transformation} in the 3D Scene’s main menu.
- To change the geometric coordinates of an object, adjust the value of the sliders. You can adjust the value of a slider by manipulating it with a [Click+Drag], or you can [Double-click] on it to open a text field where you can enter a desired numeric value.

The effects of these transformations can be seen in the 3D Scene Preview. The visual representation of the selected object will be modified as well.

Note: Slider values differ depending on the parameters they represent. The Scale sliders are not dimension sliders; they act as scaling coefficients applied to the object’s original size. For example, if the scale value of a cube featuring edges of 2 meters is changed from 1 to 4 on all three axes, the cube will now have edges of 8 meters. The Translate sliders express a value in meters. The Rotate sliders express values in angles. And the Rotate Axis sliders are used to apply a rotation expressed in an angle that corresponds to specific vectors. For example, an angle is set with the first slider while the three other
sliders represent vector values for each axis that will determine how the rotation will be applied to each.

**Transformation Manipulators**

The Transformation Manipulators facilitate direct modification of a 3D object’s parameters — Scale, Translate, Rotate — by manipulating your mouse in the 3D Scene Preview.

Enable the desired Transformations Manipulator using the following methods:

- **Scale Manipulator:** Press [X] on the keyboard or click on the Scale button located in the top-right corner of the 3D Scene window.

- **Translate Manipulator:** Press [V] on the keyboard or click on the Translate button located in the top-right corner of the 3D Scene window.

- **Rotate Manipulator:** Press [C] on the keyboard or click on the Rotate button located in the top-right corner of the 3D Scene window.

The Transformation Manipulators will appear when a 3D object is selected.

PHOTON’s Manipulators feature a standard color-scheme for its 3D coordinate system: X is red, Y is green and Z is blue.

- [Click+Drag] the handle of the axis parameter you want to modify (X, Y or Z). The handle will become yellow when selected.

- The Scale and Translate Manipulators feature a yellow dot at the intersection of their axes. [Click+Drag] the yellow dot to simultaneously apply transformations to all axes.
Note: Enabling a Manipulator will disable camera movements in the 3D Scene Preview. To switch back to camera control, press [S] on the keyboard or click the Camera button located at the top-right corner of the 3D Scene.

Note: If you want to control the camera while a Manipulator is enabled, press and hold [S] on the keyboard. This will allow you to manipulate the camera. To switch back to Manipulator control, release the [S] key.

2.13.4 Do Not Freeze the Transformations

Is Freezing necessary for LED Displays?
Since LED Screens are not Projection Surfaces, freezing transformations is therefore useless in contexts where they act as Displays.

2.13.5 Map the 3D Object to the LED Processor

In order to calibrate the LED Display you will need establish a link between the 3D object acting as a Screen and the LED Processor. The 3D object must be added to the Objects Reference list.

Note: There is no Visibility list for LED Processors. Once added to the Objects Reference list, the 3D object is automatically “made visible” because LED Displays are not Projection Surfaces.

1. Select the 3D Scene module’s Calibration mode by pressing [4] or by clicking on the [Calibration] button located at the top-right corner of the 3D Scene window.

Once the Calibration mode is enabled, the 3D Scene Preview will turn red and the Calibration Tools Window will open in the lower right part of the 3D Scene window.

2. Select the LED Display you want to calibrate by clicking on its entry in the Calibration Tools Window list. (If you haven’t renamed the LED Display, it will be listed as “LED Processor.”)

Make sure the Display Grid is enabled. The Display Grid will facilitate further operations by showing how the image texture is distributed on the Display.

3. Press [D] or click on the gear icon button to access the 3D Scene module’s Settings menu and click on the [Display Grid] toggle if the Display Grid isn’t already activated.

Add the 3D object to the Objects Reference list.
4. In the Primitive Preset window section (below the Calibration Tools Window), select the 3D object from the {Object Reference} dropdown menu.
5. Click on the [Add] button to add the 3D object as a Reference Object.

Note: Multiple 3D objects can be linked to the same LED Processor by repeating the previous steps. Inversely, the same 3D objects can be linked to multiple LED Processors.

2.13.6 Create Quads and Resample Texture

The LED Processor Display uses Quads to resample video texture and assign it to segments of the real-world LED Display. In order to calibrate an LED Display, one or many Quads will have to be created, modified and distributed while respecting the ratio of the real-world LED Display.

Create a New Quad

- Click on the [+] button located at the top of the LED Properties section of the Primitive Preset Panel in the Calibration Tools Window.

An entry named “Quad1” should appear in the Quad list located below the [+] button. Additional Quads can be created and will populate this list.
Modifying the Quad’s Size, Shape and Texture Mapping

By default, a newly created Quad has the same size as the full resolution of the output it is linked to. A new Quad is “full screen,” however, its size, shape and texture mapping can be modified to fit your needs. This can be done through two different methods:

Using the LED Options Widgets

The right side of the Calibration Tools Window contains many widgets such as dropdown menus, toggles and sliders that you can use to modify the Quad’s parameters. Below you will find brief descriptions of these options (listed from top to bottom, as in the UI):

**Primitive**
This dropdown menu assigns a specific 3D object to the selected Quad. This feature is useful in cases where multiple Screens (represented by 3D objects) are linked to the same LED Processor.

**Orientation**
This dropdown menu rotates the texture inside the Quad by increments of 90 degrees.

**[Flip]**
This toggle enables (or cancels) the geometrical reflection of the texture along its vertical axis.

**[Flap]**
This toggle enables (or cancels) the geometrical reflection of the texture along its horizontal axis.

**Texture**
These 2D sliders will change the size and position of the texture sampled by the currently selected Quad.

**Output**
These 2D sliders will change the size and position of the Quad in the video output.

Setting Texture Resolution

The texture resolution has to be set through the Screen’s texture properties.
1. Select the Screen by clicking on its entry in the Scene Primitives list. (The Screen is a 3D object you previously added to the list.)
2. Press [P] or select {Window > Properties} from the 3D Scene menu to open the Properties Panel.
3. Set the desired horizontal and vertical resolutions using the width and height sliders located underneath the Texture section of the panel. (The sliders can be manipulated with the mouse or you can [Double-click] on them to open text fields where you can directly input numerical values.)

**Setting Output Resolution**

You will need to set the LED Processor output resolution so it matches the resolution of its Video Output Port (the graphic card’s physical output).

The resolution of the Video Output Port can be found in the Settings module.

1. Press [Alt+S] or select {System > Settings} from the Main menu to open the Settings module.
2. Select the Server and the Output you want to monitor by clicking on the appropriate entries in the Photon Selection list and the Outputs list. The resolution of the Video Output Port should be indicated in a dropdown menu located in the Output Resolution window section.

The resolution of the LED Processor output can be set in the 3D Scene module.

- Press [Alt+C] or select {System > 3D Settings} from the Main menu to open again to the 3D Scene module.
- Select the LED Processor from the Calibration Tools Window display list by clicking on its entry.

The height and width sliders located in the LED Properties window section of the Calibration Tools Window can be used to set the LED Processor output resolution.

- Enter the horizontal resolution value of the Video Output Port using the width slider by either manipulating it directly with the mouse or by [Double-clicking] in it to open a text field where you can enter a numerical value.
- Enter the vertical resolution value of the Video Output Port using the width slider by either manipulating it directly with the mouse or by [Double-clicking] in it to open a text field where you can enter a numerical value.
Offset the Output
The width and height offset sliders can be used to offset the entire output.

Note: The LED Processor’s output resolution has to match the resolution of the Video Output Port found in the Settings module.

Direct Quad Manipulations in Calibration Tools Window Preview
You can manually resize and position the Quad in the video output by using your mouse. To modify the texture’s parameters follow these steps:

- Select the Quad you want to resize or position by clicking on its corresponding entry in the Quads list in the LED Properties window section or [Double-click] on its representation in the Calibration Tools Window Preview.

- [Click+Drag] inside the Quad to reposition it in the video output.

- [Click+Drag] the corners of the Quad to resize it.

Holding the [Shift] key while performing the [Click+Drag] actions on the Quad will increase the mouse’s precision.

Note: You will usually input exact values in the Texture and Output 2D sliders located in the LED Options widget rather than perform direct manipulations on the Quads since LED Displays require pixel-perfect precision. However, you can use the manual method to rapidly get a rough preview of the final LED mapping.

Note: The coordinates of the texture’s top-left corner are 0,0 (which is standard in the LED industry).

LED Processor View Modes
You can switch between two different view modes in the Calibration Tools Window Preview when an LED Processor is selected.

- Select either the {Texture} or the {Output} option from the View Mode dropdown menu located in the LED Properties window section of the Calibration Tools Window.

Output View Mode
Shows what is sent to the Video Output Port (the graphic card’s physical output).

Texture View Mode
Shows the section of the Screen’s texture that is resampled by the selected Quad.

2.13.7 Assign the LED Processor to an Output

In order to output video from the graphic card connector to the real-life LED Display, you will have to link the LED Processor to one of the Virtual Video Outputs in the Settings module.

1. Press [Alt+S] or select {System>Settings} to open the Settings module.
2. Click on the entry corresponding to the Server you want to calibrate from the Photon Selection List.
3. Once the Server is selected, make sure you identify the Virtual Video Output corresponding to the Video Output Port connected to the real-world LED Display. If the Virtual Video Output is missing, click on the [+] button to create a new one.
4. Select the LED Processor you want to assign to the Virtual Video Output by using the dropdown menu located to its right.
1. File Manager

1.1 File Manager Overview

The File Manager is a module dedicated to importing and converting media files. It also allows you to create media playlists, sort files imported on the servers, and can be used to recall Timeline media clips when programming a show (see Section 2.2 Adding Media in Chapter 4 Programming a Show).

The File Manager window can be divided into 5 window sections:

**Media Files List**

This list contains all of the media files (images, video, sound, 3D Models) that were imported in PHOTON (see Section 4. File Management and Display in Chapter 3 Importing Content).
Module Top Section
The window’s top section contains a series of buttons and toggles that include checkboxes, as well as a search field. The buttons and toggles support a wide range of functions, including media file import and conversion, and Media File list display categorization (described in subsequent sections of this chapter).

Playlist and Sorting Tool
The left section of the File Manager window contains a list of toggles that correspond to different media categories and control which items will be shown in the Media Files List (see Section 4.3 Files Visibility and Media Category in Chapter 3 Importing Content).

A [+] button located underneath the sorting tool will allow you to create custom Playlists from selected media files (see Section 5.1 Playlist Creation in Chapter 3 Importing Content).
Media Preview Panel

The top right part of the File Manager window is dedicated to media preview.

Select a media file from the Media Files List by clicking on it.
Click on the preview button to watch a preview of the content, or scroll through content by clicking and dragging the time slider located beneath the window.

To hide or show the Media Preview window, click on the play toggle located in the window top section.

**Note:** The Media Preview Panel has audio playback capabilities. If a playback device is set up in the I/O Manager, sound might play (there is a [Mute] button at the end of the timeline).

### Task List

The lower right part of the File Manager window contains a list where the progress of Import and Conversion tasks is shown in sequential order.

<table>
<thead>
<tr>
<th>#</th>
<th>Media Name</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>I-1</td>
<td></td>
<td>Ready to import</td>
</tr>
<tr>
<td>I-2</td>
<td></td>
<td>Ready to import</td>
</tr>
<tr>
<td>I-3</td>
<td></td>
<td>Ready to import</td>
</tr>
<tr>
<td>C-1</td>
<td></td>
<td>Ready to convert</td>
</tr>
<tr>
<td>C-2</td>
<td></td>
<td>Ready to convert</td>
</tr>
<tr>
<td>C-3</td>
<td></td>
<td>Ready to convert</td>
</tr>
</tbody>
</table>

The Task list has 3 slots for importing media files (copying media files via the network to the devices in the Server Group) and 3 slots for media conversion (creating local VCI copies of the original media files; VCI is VYV’s own uncompressed file format).

Ongoing tasks can be:
- paused by clicking on the button;
- resumed by clicking on the button;
- cancelled by clicking on the button.
These actions will impact the entire Task list. Other actions, such as “re-prioritize” or “cancel a single task,” can be achieved by using the contextual menu which can be opened by right-clicking on a task.

To hide or show the Task list, click on the toggle located in the window’s top section.

1.2 File Manager Settings

Click on the button to open the File Manager Settings window. This window contains various parameters that will affect PHOTON’s behavior when performing media imports and conversions.

1.2.1 Import Settings

This section contains 2 checkboxes:

- **Enable Image Sequence**: This option supports the creation of a single container for video rendered from .jpeg, .png, .tga or .tiff image sequences.

  Note: The VCI created from an image sequence will automatically have your project’s frame rate (see Settings > General).

- **Refresh model library after import**: If activated this option will enable an automatic refresh of the model library after an import. If deactivated, it will prevent 3D models imported through the File Manager from loading automatically in the 3D Scene in memory. This option can be useful if you don’t want servers to stutter during a viewing session but still need to import 3D objects.

1.2.2 Splitting

When dealing with very large media files and Screens, you might have to split your content in order to be able to play it back and apply crossfades between files.
With the Splitting dropdown menu you can select 3D Models functioning as Screens, and activate media splitting. This function will split media files during conversion, and only select the portions of the media files needed by the servers for playback.
In order to access the screens through the menu, they should already be instantiated in the 3D Scene and their [Splitting] toggle should already be activated through their {Properties > Blending Options} panel. For PHOTON to know which portion of the media file each server needs for playback, outputs have to be set correctly and the projectors assigned to them must be calibrated with the screen.

Splitting for Multiple Screens

If split content needs to be sent to more than one server in a project (this might happen if content is used in different Screens), you will have to change the screen splitting selection. You will also have to re-convert the files for the other screens because this option only allows you to split content for one screen at the time.

1.2.3 Conversion Settings

This section contains 2 checkboxes:

- **Auto Convert After Import**: If this option is selected, media conversion will start automatically when media is imported.
- **Delete Original Media After Conversion**: If this option is selected, original media files such as .mov or .png will be deleted once they are converted to VCI. While this frees up disk space, it might prevent you from synchronizing your media from scratch in cases where a new server is integrated in the Server Group. (Note that this action will delete files previously copied on the servers, but not the original files residing on a network drive.)

1.2.4 File Format Conversion Dropdown Menu

Selecting an item in this menu will determine the destination file format for conversions. The menu contains 3 items:
- **VCI**: VYV’s video file format that does not feature any time compression. It should be the preferred format.
- **VCI Compressed**: VYV’s video file format featuring time compression similar to H.264.

### 1.2.5 Mpixel Limit Sliders

This section contains 2 sliders:

- **Mpixel Limit Slider**: This slider will set the megapixel threshold for Display Servers and Display Master Servers. If the media file resolution is greater than the import threshold PHOTON will automatically reduce the resolution so it respects the megapixel limit.
- **Preview Mpixel Limit**: This slider will set a megapixel threshold for Controller Servers. Since the Controller will playback all of the screens in your installation, it will reduce the size of your media files. If the media file resolution is greater than the import threshold PHOTON will automatically reduce the resolution so it respects the megapixel limit.

### 1.2.6 GPU Conversion Toggle

PHOTON’s file conversions are usually done by the server’s GPU (Graphics Processing Unit). This option for converting files has been the default since Windows 7 build 7264. The GPU can be changed so the Central Processing Unit (CPU) can take care of the conversion tasks. Note that some encoding formats (YUV422 and YV12 for example) do not allow GPU conversion and will disable the GPU conversion option.

### 1.2.7 Video Encoding Format Dropdown Menu

This dropdown menu allows you to choose the type of color encoding system that will be used when converting video files.

- **YUV 4:2:0** is an encoding format where the chroma channels are sampled at half the rate of luma, occupy half the horizontal resolution and are interlaced.
- **YA16 - (4:2:0 + alpha)** is the same as YUV 4:2:0 but includes a channel dedicated to alpha content. This encoding system is our preferred option because it is the only one that allows our system to split media content in real time.
- **YUV 4:2:2** is an encoding format where the chroma channels are sampled at half the rate of luma.
- **RGB 4:4:4** is fully uncompressed.
● **Auto** will automatically choose between YUV 4:2:0 and YA16 depending on the presence (or not) of an alpha channel.

1.2.8 Task Group Selection List

Each entry in this list corresponds to one of the servers included in the Server Group (their names are preceded by checkboxes). All of the servers with a green check mark in the checkbox will be included in file import and conversion processes because they are part of the network ring.
2. Imports

Content imported into a PHOTON Project will be distributed to all servers in the Server Group. This behavior reflects the structure of the PHOTON Network (see Section 1.1 PHOTON Network in Chapter 2 Setting Up a Show), which uses a ring topology to ensure that content is distributed through all of the servers without relying on a central node. When an Import command has been issued from a Controller Server or a Display Master Server, the system will maintain the integrity of media files as they are being distributed to all devices. The use of a network ring makes PHOTON resilient to potential connectivity failures and facilitates the creation of live back-ups.

Servers operating under Albion System Mode {Settings > Photon} will only receive 3D object files and will be discarded from the network ring when media files are transferred.

2.1 Importing 3D Objects

1. Click on the Import button located in the top left corner of the File Manager window.
2. A Windows dialog box will pop up, allowing you to search for and select the file you want to import into your PHOTON Project.
3. To filter out other items — unneeded video, image or audio files — select 3D Files from the dropdown menu located on the right.
4. Use the folder tree structure to locate your files. You can select and import multiple files at the same time. Select the files you want to import by clicking on them.
5. Once all of your files are highlighted, click on the [Open] button.
2.2 Importing Media

1. Click on the Refresh button located in the top left corner of the File Manager window.
2. A Windows dialog box will pop up, allowing you to search for and select the file you want to import into your PHOTON Project.
3. To filter out other items — unneeded video, image or audio files — select Video Files, Image Files or Audio Files from the dropdown menu located on the right to.
4. Use the folder tree structure to locate your files. You can select and import multiple files at the same time. Select the files you want to import by clicking on them.
5. Once all of your files are highlighted, click on the [Open] button.

2.3 Import Folder

You can access the Import Folder by using the VYV custom file dialog. Select a root folder and press the [Import Folder] button. PHOTON will automatically scan all of the child folders selected and import all relevant files contained in this folder structure.

2.4 Import Order Management

When importing a large number of files, you might be asked to display one or more files on the Screens before displaying others. While the Media Task list displays all of the files waiting to be imported, it is possible to prioritize the import of files in the list by right-clicking on a file’s name and selecting {Move On Top}. This action will change the order of priority for importing and converting files.
2.5 Pause/Resume/Cancel Imports

The Task list located in the lower right part of the File Manager window facilitates the management of ongoing imports.

Imports can be:
- paused by clicking on the Pause button;
- resumed by clicking on the Resume button;
- cancelled by clicking on the Cancel button.

These actions will impact the entire Task list. Other actions, such as “re-prioritize” or “cancel a single task,” can be achieved by using the contextual menu, which can be opened by right-clicking on a task.
3. Conversions

In order to playback visual content in PHOTON, you have to convert your media files — .jpeg, .png, .targa, .tiff, .mov, etc. — to the .vci file format. .vci media conversion does not compress media. Prior to file conversion, you should choose what kind of video encoding you will apply to the media content. Compression can only be done in color space. PHOTON is a frame accurate system and does not support temporal or spatial compression.

3.1 Conversion Options

1. Click on the Settings button [pixbutton] to open the File Manager Settings window.
2. Use the Color Encoding Format dropdown menu to select the color encoding system that will be used during conversion:

   - **YUV 4:2:0** is an encoding system where the chroma channels are sampled at half the rate of luma, occupy half the horizontal resolution and are interlaced.
   - **YA16 - (4:2:0 + alpha)** is the same as YUV 4:2:0 but includes a channel dedicated to alpha content. This encoding system is our preferred option because it is the only one that allows our system to split media content in real time.
   - **YUV 4:2:2** is an encoding system where the chroma channels are sampled at half the rate of luma.
   - **RGB 4:4:4** is fully uncompressed.
   - **Auto** will automatically choose between YUV 4:2:0 and YA16 depending on the presence (or not) of an alpha channel.
3.2 Convert Media Files

1. Make sure you have selected the appropriate Color Encoding Format before starting media conversion (see article 3.1 Conversion Options in Chapter 3 Importing Content).
2. Make sure the media file you are about to convert was properly imported into all of the servers in your Server Group.

Look at the Media Files List. The first column to the left should be titled “Net” (if the column is missing from the table, right-click in the header to add “Net” with the help of a contextual menu). A green check mark should precede all of the original media files that you want to convert. If a media file is preceded by a red X mark, it means the file wasn’t properly imported into all of the servers in the group. This problem can be solved in different ways depending on its cause:
- **The Media Files List was not refreshed:** Click on the Refresh button [pixbutton] located at the top left corner of the File Manager window to refresh the Media Files List.
- **The import was not completed:** Check the Task list in the lower right corner of the File Manager window. Media files might still be importing or the import could have failed.
- **A server was removed from the Server Group:** Return a server to the network ring by rebuilding the Server Group in the Settings window and relaunching the Conversion (or relaunch Import if the media file is missing).

When the media files are consistent on all of the servers in the network, you are ready to start the conversion.

3. Select the original files you want to convert by clicking on their name in the Media Files List and then click on the Convert button [pixbutton]. You can also select files that you want to convert by right-clicking on entries in the Media Files List to open a contextual menu and then selecting {Convert}.

### 3.3 Pause/Resume/Cancel Conversion

To manage media files while they are being converted use the Task list module located in the lower right part of the File Manager window.

Conversions can be:
● paused by clicking on the Pause button;
● resumed by clicking on the Resume button;
● cancelled by clicking on the Cancel button.

These actions will impact the entire Task list. Other actions, such as “re-prioritize” or “cancel a single task,” can be achieved by using the contextual menu which can be opened by right-clicking on a task.

3.4 Conversion on Display Servers or Display Master Servers

Conversion is not an instantaneous process. The Task list will display a “Conversion Net” rate (measured in percentages), which indicates how much of the original media file has been converted on the Display Servers (or Display Master Servers) in the network.

The conversion process will create downsized media files on Controller Servers. This speeds up the process and provides early access to the files so you can begin to place them in the Timeline and preview content right away. Keep in mind that the files will probably still be converting on the Display Servers (or Display Master Servers) and images won’t be projected until this process is completed.
4. Files Management and Display

4.1 Media Files List

By selecting the detailed Media Files List format – it is selected by default, but you can also manually select it by clicking on the Show Detail View button – you will have access to data related to a selected media file’s resolution, FPS, duration, etc. The Media Files List features columns that display this data. If you want the Media Files List to show or hide specific kinds of media file data, right-click in the header. A contextual menu will open and allow you to alter the list’s columns (and therefore, its data categories).

The “Net” column in the Media Files List will show a green check mark if a specific file has been imported and is available on all of the servers in your Server Group. If there is a red X in the “Net” column, the file is not currently available on all servers in the network. Moving the mouse cursor over the column will display a pop-up window that indicates which servers have the file and which do not.

You can interact with the items in the Media Files List by right-clicking on them. Doing so will open a contextual menu that lets you:

- Delete a file;
- Convert a file (only on original files);
- Sync Selected, which synchronizes a file on all servers in the Server Group (this is useful if you added a new server to a PHOTON Project or are missing a file on a specific server);
- Force Refresh a file’s thumbnail;
- Show in Folder, which opens a Windows file explorer in PHOTON’s “content” folder where the selected file is highlighted.

4.2 Display the Media Files List as Thumbnails or as a Detailed List

The Media Files List can be viewed as a series of thumbnails or as a list that includes detailed information about the files.
Show Thumbnail View
Click on the Show Thumbnail View button located in the top left corner of the File Manager window to view the Media Files List as thumbnails.

Show Detail View
Click on the Show Detail View button located in the top left corner of the File Manager window to view the Media Files List as a detailed list.

4.3 File Order
Items in the Media Files List can be arranged in an order based on their attributes, so long as they are represented by a data category in the list’s table.

1. Move the mouse cursor over the top row of the Media Files List table that shows the data categories. Arrows pointing upward and downward should appear near each data category.
2. Click on the upward arrow to sort files in an ascending order.
3. Click on the downward arrow to sort files in a descending order.

Note: The order chosen for a specific playlist in the File Manager module will be shared in the Media Properties window section of the Timeline.

4.4 File Display and Media Types
The left section of the File Manager window contains a list of toggles that represent different media types. The toggles can be used to select a specific media type and filter out the other kinds of media contained in the Media Files List.
4.5 File Search

There is a search field at the very top of the File Manager window that will allow you to look for specific files in the Media Files List.

- To find a specific file in the Media Files List type its name into the search field.

Note: File extensions are also taken into account. For example, by typing ".png" in the search field, you will limit your search to .png files.

4.6 Group Original and Converted Files

The Group checkbox allows you to create a parent-child group where the original media file and the .vci version of it will be included.

4.7 Hide Original Files

The Hide Originals checkbox allows you to mask original media files. .vci files that were created from these originals by means of conversion are the only ones that will be shown.

4.8 File Synchronization

Normally, all files should be present on all servers, therefore allowing any server to backup the others at any time. If all of a PHOTON Project's servers were included in the Server Group prior to importing files, this should be the case. There are very few exceptions to this. (The ALBION Server is an exception, and will not have a local copy of media files.)

If for any reason a media file is missing on one of the servers, you can synchronize the selected file across the network. This operation will send the file to every server, where it will be reconverted.

- Right-click on the file in the Media Files List and select (Sync Selected) from the contextual menu to launch synchronization.
Note: To be able to synchronize a media file across the network, the server from where the operation is being launched must have the original file. .vci files cannot be synchronized.
5. Playlists

Playlists are collections of media files created by users. They are helpful when programming shows because they can provide access to categorized media content banks. They should be considered a must for shows that use numerous media files.

5.1 Playlist Creation and Management

A [+] button located under the Sorting Tool (the itemized column on the left side of the File Manager window) will allow you to create Playlists from selected media files (see Section 5.1 Playlist Creation in Chapter 3 Importing Content).

- Press the [+] button to create a new Playlist.
- Drag and drop media files from the Media Files List onto the “New Playlist.” They will be added to the Playlist.
- By clicking on a Playlist, the Media Files List will only show files that have been added to that specific Playlist.
- By selecting a Playlist and starting an Import, all of the imported files will automatically be placed in the Playlist.
- Deleting a Playlist will not delete the media files identified in it. It will only delete the list.
• Playlists can be duplicated, deleted and renamed by using a contextual menu. Right-click on a Playlist to access this menu.

• By right-clicking on selected Media clips in the Timeline a contextual menu will open and offer the {Create Playlist with Clips} option. If this option is selected, a Playlist containing the selected media files will be generated.
1. Cue Editor

The Cue Editor module facilitates the creation of cues.

Cues are pre-recorded series of actions and parameter modifications set in a specific order of execution. This sequence of actions can be affected by variables such as delays, timings and target values. In other words, any parameter, slider, toggle, or dropdown menu found in PHOTON's UI can be affected by a cue.

Cues can be recalled in various ways and function like programmable macros found in other types of systems (see Section 1.8 Triggering a Cue in Chapter 4 Programming a Show). Cues can even execute complex technical procedures such as seamless live backup switching.

Note: Since cues are recalled states of parameters, no change will occur in the software if the targeted parameters are already set at the state specified in the cue. For example, if a pre-programmed cue containing an event that would set the Master Contrast slider to the value of 100 is triggered while the Master Contrast slider is already at 100, nothing will happen.

Note: Since cues can recall parameter changes, it might be tempting to use them to create animations. Do not do this. Cues are not the proper tool to create animations through interpolations between values. They should only be used to push predefined states during the linear unraveling of a show. If you wish to create animations please refer to the Keyframe Editor module (see Section 8 Keyframe Editor in Chapter 4 Programming a Show).

1.1 Cue Editor View Modes

1.1.1 Open the Cue Editor

- Open the Cue Editor by selecting {Show > Cue Editor} or by pressing [Alt+Q].

If the Cue Editor appears as a small column, it is set in View List mode, which is the small-scale representation of cues designed for operation. The View List mode is meant to show pre-programmed cues that are to be recalled. It is not used for creating new cues.
If you wish to create new cues, you will need to switch the module to View Full mode.

1.1.2 Toggle Full View or List View

- To expand or reduce the Cue Editor select {View > View Full} or {View > View List} or press [V] on the keyboard to toggle between the two view modes.

The top part of the of the left column shows Cue playlists (see Section 1.7 Cue Playlists in Chapter 4 Programming a Show), while the bottom part shows the available pre-
programmed cues organized into the Cue list. The search field located at the top of the column lets you filter the list of cues by entering characters.

In View Full mode, the module’s window will expand to the right in order to reveal the Edit cue window section. This is where you can adjust all the timings, delays, actions order, etc. for newly recorded cues. At the bottom right of the module’s window you will find the Progress view window section, which is where you will be able to follow the progress of cues being executed.

1.2 Cue Recording

1.2.1 Create a New Cue

- To create a new cue, press the [+] button at the bottom left part of the module. The new cue will appear at the bottom of the Cue list.

1.2.2 Record Actions in a Cue

- To record actions in a new cue, press the [Record] button at the top right of the Edit Cue window section.

If the Cue Recording mode is activated, the entire UI will turn red and you will see the words “Cue Recording” at the bottom right of the screen.
If the Cue Recording mode is activated, every time you click on a slider, toggle, list, parameter, etc., they will appear as actions in the Edit Cue window section (see Section 1.1 Cue Editor View Modes in Chapter 4 Programming a Show).

- Press on the [Record] button again to stop cue recording.

### 1.3 Editing the Cue Actions List

Once you have recorded all of the actions needed for a new cue, you can edit the cue’s Actions list.

Actions within a cue can be reordered by dragging and dropping their names in the list.

#### 1.3.1 Reorder Actions in a Cue

Actions can also be reordered by clicking on the [Delay] button at the top of the Delays column in the Edit Cue window section. A sort will be performed on the Actions list to arrange them based on their delay time (from the lowest delay time to highest).

#### 1.3.2 Delete, Duplicate or Rename Actions in a Cue

Right-click on the name of any action within a cue to open a contextual menu to delete, duplicate or rename the action.

Note: You don’t have to be in Cue Recording mode to edit a cue.
1.4 Modifying Cues

There are 5 parameters that can be used to modify cues: Delay, Offset and Multiple Delays, Timing, Target Values and Easing.

1.4.1 Delay

Delays are absolute time values that can be understood as a “wait time” before an action is executed.

To delay the execution of an action, use the Delay slider beside it to set a time. You can also double-click on the Delay slider and enter a specific duration in a text field.

Note: Keep in mind that even if the actions inside the cue are organized as a sequence, individual delay times for actions are not cumulative. For example, Action #1 has a delay time of 4 seconds and Action #2 has a delay time of 2 seconds. Even if Action #1 is the first in the list, it will be executed after Action #2 since its delay time is higher. In this example, Action #2's delay time is definitely 2 seconds not a cumulative 6 seconds.

1.4.2 Offset and Multiple Delays

The time slider and the [Apply Offset] button at the top of the Actions list allow you to automatically offset the delay value for all of the actions selected for a cue. Follow these steps to apply an offset to multiple actions:

1. set a value in the time slider;
2. select the actions you want to be affected by the offset by pressing [Shift+right-click] on the first and the last actions that you want in the list, or press [Ctrl+right-click] to select actions that aren’t listed consecutively;
3. press the [Apply Offset] button.

All the selected actions will be offset by the value set in the time slider from top to bottom.

1.4.3 Timing

Parameter changes can be interpolated over time. Timings are values that will determine how much time the change will take. Some actions, like a true/false toggle, will not allow the use of timings because they are restricted to parameters linked to sliders.

- To set a timing for an action, use the time slider beside it to set a time. You can also double-click on the time slider and enter a specific time in a text field.
1.4.4 Target Values

When created, some actions specify a target value to be reached on the execution of the cue. You can change this value after the cue has been recorded if you want to make adjustments.

- To change the target value of a specific action click on the Target Value cells that you want to modify.

Depending on the type of data represented, you might have access to a simple toggle or a slider. For a slider, double-clicking on the Target Value cell will open a text field where you will be able to enter the desired value using your keyboard.

1.4.5 Easing

Interpolation created through the use of the timing variable is expressed in a linear way. Under certain circumstances (to smooth a transition, create an expressive transformation, etc.), it might be appropriate to ease in and out of the linear progression from the initial value to the target value.

- To ease in or ease out of an action, click and drag the Ease in or Ease out sliders to select a value, or double-click on the sliders to set values through a text field.

1.5 Rename, Duplicate or Delete Cues from the Cue List

Cues can be renamed, duplicated or deleted from the Cue list.

1.5.1 Rename a Cue

- [Right-Click] on the cue to open a contextual menu from which you will select {Rename}.

1.5.2 Duplicate a Cue

- [Right-Click] on the cue to open a contextual menu from which you will select {Duplicate}.

1.5.3 Delete a Cue

- [Right-Click] on the cue to open a contextual menu from which you will select {Delete}. 
You can also delete the cue by selecting it and pressing [delete] on your keyboard.

1.6 Nested Cues

Nesting allows the incorporation of autonomous structures into other structures. For example, video editing software facilitates the integration of pre-edited sequences into other sequences.

PHOTON allows the nesting of cues into other cues. This means that cues, which are already sequences of actions, can in turn be placed and recalled within larger sequences. This makes it possible to construct complex cues that trigger multiple actions and, with a combined use of delays, the automation of tedious tasks and interventions.

1.6.1 Nesting a Cue

- To nest a cue within a cue, recall the cue you want to nest while Cue Recording is enabled for the “meta-cue.”

Note: A safety mechanism is in place to prevent the creation of infinite loops in nested cues.

1.7 Cue Playlists

The Cue Editor facilitates the creation of Cue playlists, which are specially arranged collections of cues that make programming a show much easier.

1.7.1 Create a Cue Playlist

- Press the [+] button in the top left part of the Cue Editor to create a Cue playlist.

1.7.2 Add a Cue to a Cue Playlist

- Drag and drop the cue from the bottom left to the top left in the desired playlist.
1.7.3 Remove a Cue from a Cue Playlist

- Right-click on the cue to open a contextual menu from which you will select {Remove}.

1.8 Triggering a Cue

Cues can be triggered using the following methods:

1.8.1 Manual Trigger

- Click on the [GO] button next to a cue in the Cue playlist.

1.8.2 Timeline Trigger

- Create a Cue Clip type on the Timeline (see Section 2.3 Clip Type in Chapter 4 Programming a Show) and assign the desired cue to it. As soon as the playhead intersects with the clip, the cue will be triggered.

1.8.3 Midi Trigger

- Create a mapping between the [GO] button in front of the cue and a button located on a midi board by using the Mapping Manager module. The cue can then be recalled through interaction with the external MIDI device.

1.8.4 UDP Trigger

- Use the Project’s Show Control port found in {Settings > Network} to send a UDP command from a third-party software.
2. Timeline

The Timeline module can be broken up into different subsets of tools. Each subset corresponds to a specific window section of the Timeline module (with the notable exception of the Color Correction Tools which have their own window). This section of the manual focuses on the Timeline Editor window section, which is used for organizing media, cues, effects, etc.

The lower section of the Timeline window is called the Timeline Editor and regroups the tools you will use to edit a Show. Shows are constructed by placing Clips sequentially in the tracks of the Timeline.

The horizontal axis of the Timeline shows the time progression of a Show, expressed in hours:minutes:seconds:frames.

Screens (see Section 2.1.2 Screens in Chapter 4 Programming a Show) are positioned on the vertical axis of the Timeline. Each Screen can contain one or many Layers, which in turn contain different types of Clips: media, cues, effects, etc.

2.1 Sequences, Screens, Layers and Clips

Many different structures are used to organize media, cues, effects, etc. on the Timeline. Make sure you have a good understanding of what these structures do and how they are used. The following sections of the manual (from 2.1.1 to 2.5.4) provide information on how Sequences, Screens, Layers and Clips are used.

2.1.1 Sequences

A Sequence contains all of the Screens, Layers and Clips used in a project, and it provides a representation of the Show's temporal structure. This is where you will organize and edit media, cues, effects, etc.
A project can have multiple Sequences, but you can only render one Sequence at a time (i.e. the Sequence that is currently selected). Additional Sequences can be used as editing bins to build specific segments of a Show or to hold alternative versions of it.

Select a Sequence
To select a Sequence:
- Click on a Sequence tab to activate a specific Sequence and access its content.

Create a Sequence
There are three ways to create a new Sequence:
- Click on the [+ ] button located to the right of the Sequence tabs; or
- Press [Ctrl+T] with the Timeline module in focus; or
- Select {File > Add sequence} from the Timeline menu bar.

Delete a Sequence
To delete a Sequence:
1. [Right-click] on the tab linked to the Sequence you want to delete. This will give you access to its contextual menu.
2. Select {Delete} from the contextual menu.

2.1.2 Screens
Any 3D object that was created or imported in the 3D Scene will become a Screen (with the notable exception of Decorative Objects). Screens are virtual structures that represent real-world projection screens. A Screen will coexist in the 3D Scene module (where it is created,
then calibrated) and in the Timeline module. Each Screen has its own section of the Timeline, where you can create all of the Layers it will hold.

Create Screens

Screens are not created in the Timeline module per se. When a 3D object is added in the 3D Scene, PHOTON will automatically recognize it as a Screen. A newly created Screen will add its own section to the Timeline.

Collapse and Expand Screens

In order to collapse or expand a Screen you can either:

- Double-click on the Screen’s Layer; or
- Click on the small triangle located beside the Screen’s name.

Add Screen Metadata

It is possible to add text metadata to a Screen by accessing the Screen Properties (see Section 5 Clip Properties in Chapter 4 Programming a Show). The metadata attached to a Screen can
be used to show or hide specific Screens when executing a search command. For example, if you add text metadata such as “Aisle Screens” to some of the Screens as a way to identify them, you can easily find them when performing a search.

**Screen Render Resolution**

Screens have a render resolution. The render resolution represents the amount of pixels used to display images on a Screen. You can set a Screen’s render resolution by adjusting its width and height parameters in the Screen Properties (see Section 5 Clip Properties in Chapter 4 Programming a Show).
Note: When determining a Screen’s resolution many different factors need to be taken into account: the Screen’s physical size, its ratio, the distance between its position and the audience, and the resolution of the media that will be displayed on it should be considered. The best practice when choosing resolution is to match the ratio of the Screen and the resolution of the media that will be displayed on it. Insufficient resolution will result in a pixelated image. Using a higher resolution than the media being displayed is a waste of computing resources.

**Search for a Screen**

A search box is located at the top of the Layers list. You can enter text in the box to filter out some of the Screens on the list.

Screens that remain visible in the Layers list will be the ones that match the name or metadata tag entered into the search box. Note that the names of the 3D objects from which the Screens originate are taken into account by the search box filter.
The Root

The Root can be thought of as an invisible Screen that holds various Clip types (see Section 2.2 Clip Types in Chapter 4 Programming a Show). These Clips are independent from any of the actual Screens created in the 3D Scene. Clips placed in the Root can be referenced by other Clips (such as Proxy Clips, Stack FX Clips, FX Graph Clips, etc.).

It is considered a best practice to place Cue Clips in the Root because by doing this they will appear at the top of all of the other Screens. Also, since the search box filter affects the visibility of the Screens but not the Root, Cues placed in the Root will always be visible.

2.1.3 Layers

Layers are represented as horizontal tracks in the Timeline. They can store many Clips horizontally. Layers can be stacked up vertically to create composited scenes. Layers are also useful when building real-time effects by combining multiple Stack FX Clips. They are also useful in contexts where automation relies Cue Clips.

Note: Unlike Adobe After Effects, PHOTON’s Layers can hold many clips.
Create New Layers

To create a new Layer:
1. Select one of the Screens (or the Root) by clicking on its entry in the Layers list;
2. Click on the [+] button located in the Master Layer panel.

The new Layer will be added at the bottom of the Layers list.

By pressing [Ctrl+⁻] the new Layer will be inserted directly below the Layer that is currently selected.

Note: A newly created Layer might not be immediately visible. You have to [Double-click] on the Screen or on the triangle found next to the Screen’s name in order to reveal the Layers stored inside it.

Reorganize the Layer Order

All Layers can be manipulated with the mouse in order to change their position in the Layers list:
- [Click+Drag+Drop] any Layer to where you want it.

Layers can also be dragged from one Screen to another using the same method.

Layer Rendering Order

In PHOTON, the rendering order is organized sequentially, from top to bottom. This means the lowest item in the list will always be the last one rendered, and as a result it will be placed on top of the composition. This design applies to both the Timeline module (where compositing is done) and the 3D Scene list.

It is important to remember that the logic of PHOTON’s rendering order is the inverse of Adobe’s image compositing software.

2.1.4 Clips

A Clip is a container that can hold various time-based components such as media, cues, effects, etc. (see Section 2.2. Clip Types in Chapter 4 Programming a Show for a complete list of the Clip types and their description).
Clips are placed within Layers (which in turn are placed in Screens, or in the Root). Stacking Clips vertically in the Layers belonging to the same Screen (or in the Root) will allow the creation of visual compositions through Layer blending (see Section 4.3 Blending – Create Compositions in Chapter 4 Programming a Show).

Clips have a fixed duration defined by their borders. By default, the duration of the newly created Clip will match the duration of the whole project.

Note: The Clip’s default duration can be changed by entering a new temporal value for Clips in the field located in the Timeline Default values window. To access the Timeline Default values window click on the General tab in the Settings module.

Add Clips

- [Right-click] on any track on the Timeline (each Layer has its own track) to open a contextual menu that contains the following options for adding new Clips (or use the dedicated shortcuts in the Timeline module):
  - Add Empty Clip [Ctrl+N]
  - Add Media Clip (Image, Video, Sound) [Ctrl+M]
  - Add FX Stack Clip [Ctrl+E]
  - Add FX Graph Clip [Ctrl+W]
  - Add Virtual Projector Clip [Ctrl+R]
  - Add Input Device Clip [Ctrl+I]
  - Add Cue Clip [Ctrl+U]
  - Add Proxy Clip [Ctrl+P]
  - Add Composer Clip [Ctrl+G]
Add Composition Clip [Ctrl+H]
Add Shadow Session Clip [Ctrl+O]

- [Drag+Drop] a media file from the File Manager module onto a track to create a new Media Clip.

**Select a Single Clip**
- Click on a Clip to select it.

**Select Multiple Clips**
- [Ctrl+Click] on Clips; or
- Draw a selection square across the Layers to perform a group selection. (This only works if you draw the selection square within the tracks (identified by the lighter grey area.)

*Note: The selection square works across Screens.*

**Delete Clips**
- Select the Clips you want to delete and press the [Delete] key. A Confirmation Box will open to make sure you really want to delete the Clip. Click on the [Delete] key to delete the Clip.

**Change Clip Type**
Clip capacities (media playback, send a cue, etc.) are defined by their type (media, cue, effect, etc.). A Clip type is selected whenever a Clip is created.

You can also change a Clip type later on without affecting its duration or location in the Timeline by doing the following:
- Select the Clip and then select an option from the Clip Type dropdown menu located in the Shared Clip Properties window section of the Timeline module.

*Note: The Clip type cannot be changed when multiple Clips are selected.*

**Change Clip Colors**
1. [Right-click] on a Clip (or a group of multi-selected Clips).
2. Select {Change color} from the contextual menu. A color picker pop-up window will open. Choose the desired color and close the color picker.

**Reset Clip Colors**
1. [Right-click] on a Clip (or a group of multi-selected Clips).
2. Select {Reset color} from the contextual menu. The selected Clips will reset their color to the default specified in the Settings module.

**Change a Clip Type Color**
1. Press [Alt+S] or select {System > Settings} to open the Settings module.
2. Click on the General tab to access the Default Clip Colors list.
3. Click on any of the Clip type buttons in the list to open a color picker pop-up window.
   Choose the desired color and close the color picker.

### 2.2 Clip Types

**Empty Clip [Ctrl+N]**
Empty Clips act as empty shells that don’t contain anything. They are mainly used to add operation notes in the Timeline. The default color for representing Empty Clips is grey.

**Media Clip [Ctrl+M]**
Media Clips contain different kind of media: single frame images, videos and sound files. The default color for representing Media Clips is red.
FX Stack Clip [Ctrl+E]
FX Stack Clips act as adjustment Layers, transforming one or two sources with real-time effects (blur, glow, etc.). There are more than one hundred different kinds of effects. The default color for representing FX Stack Clips is light blue.

FX Graph Clip [Ctrl+W]
FX Graph Clips refer to a specific Graph created in the FX Graph module. The FX Graph module is a graphical programming interface that is used to create effects, manage particles, program logic functions and integrate incoming data from the 3D Scene. The default color for representing FX Graph Clips is deep blue.

Virtual Projector Clip [Ctrl+R]
Virtual Projector Clips re-project content from a point of view defined by the position and orientation of its corresponding Virtual Projector in the 3D Scene. They virtually project images onto Screens, modifying their texture in the process. Virtual Projector Clips are often used in interactive effects used in combination with camera mapping. The default color for representing Virtual Projector Clips is yellow.
**Input Device Clip [Ctrl+I]**

Input Device Clips refer to input devices such as video acquisition cards, cameras and NDI streams accessed through the I/O module. An Input Device Clip will display its texture (the incoming video feed) onto the Screens they are placed in. The default color for representing Input Device Clips is mauve.

**Cue Clip [Ctrl+U]**

Cue Clips refer to Cues which are macro commands created with the help of the Cue Editor module. They are triggered by PHOTON when the Playhead intersects with the boundaries of the Clip. The default color for representing Cue Clips is green.

**Proxy Clip [Ctrl+P]**

Proxy Clips allow you to distribute a reference texture originating from another Clip to other Screens. The source Clip (media, live input, etc.) is usually placed in the Root. Using Proxy Clips reduces the load on the GPU and the disks because the texture is only read once even if its content is displayed on multiple Screens. The default color for representing Proxy Clips is purple.
Composer Clip [Ctrl+G]
Composer Clips allow you to “bake” a visual composition (a single image composed of many Layers of content) that can be referenced to by Clips placed on a Layer below in the Timeline. This is very useful because most of the parameters set in the Shared Clip Properties are not transferred when sourcing Clips in PHOTON. The default color for representing Composer Clips is orange.

Composition Clip [Ctrl+H]
This feature is still in development and should not be used in Shows. Composition Clips allow you to encapsulate a section of the Timeline into a Sub-Timeline that can be visualized by opening the tray at the bottom of the Timeline window. The default color for representing Composition Clips is brown.

Shadow Session Clip [Ctrl+O]
Shadow Session Clips allow you to playback PSN (PosiStageNet) data recordings. The default color for representing Shadow Session Clips is aqua.
2.3 Screen and Layer Timeline Properties

Three toggles and a slider are located to the right of the Screens and the Layers in the Timeline. They can be used in the following ways to affect both Screens and Layers:

![Screen and Layer Timeline Properties](image)

**Cancel Rendering for a Screen or Layer**
- Click on the Lighting toggle to cancel all image rendering for its corresponding Screen or Layer on the connected Display Servers.

Cancelling image rendering makes manipulation invisible in its corresponding Layer or Screen.

**Lock a Screen or Layer**
- Click on the Lock toggle to prevent any modifications to its corresponding Screen or Layer.

The Lock prevents unwanted changes.

**Hide a Screen or Layer**
- Click on the Eye toggle to turn its corresponding Screen or Layer to black.

**Modify Alpha for a Screen or Layer**
- [Click+Drag] the Alpha slider to modify the alpha channel value for its corresponding Screen or Layer.

2.4 Add or Replace Media

**Add Media**
1. Create a new empty Media Clip on the Timeline by using one of these methods:
   - [Right-click] on a Layer track and select the {Add Media} option from the contextual menu; or
Click on a Layer to select it, then press [Ctrl+M].

Note: This will create a Media Clip with a duration that corresponds to the duration of the Timeline.

2. Click on the empty Media Clip to select it. The Clip Properties window section of the Timeline module will reflect your selection and its name will change to "Media Properties."
3. Select an item from the Media File list by clicking on its entry. The selected media file will be loaded onto the Media Clip and will loop to match the Clip’s duration.

Add a Specific Media File as a Media Clip in the Timeline
- [Drag+Drop] a media file from the File Manager module onto the Timeline. A new Media Clip linked to the selected media file will be created. The Clip’s duration will match the duration of the media file (even if it is a single frame or still image).

Replace the Media File linked to a Media Clip
There are two methods to replace the media file linked to a Media Clip on the Timeline:
- Click on the Media Clip to select it and then [Double-click] on the desired media file located in the File Manager module; or
- Click on the Media Clip to select it and choose a media file from the Media File list located in the Media Properties window section.

Note: None of these actions will alter the duration of the Media Clip.

2.5 Timeline Navigation

2.5.0 The Playhead
The Playhead is a mobile time marker that reads the Timeline’s content and indicates the current time of the Show. It is represented by a downward-pointing red triangle located on the Timeline.

2.5.1 Playhead Positioning

Position Playhead using the Mouse

Use the following methods to position the Playhead with your mouse:

- [Left-click+Drag] inside the black area of the Timeline (also known as the Time Bar) to move the Playhead; or
- [Left-click+Drag] the Playhead to move it across the Time Bar; or
- [Double-click] in the black area of the Timeline (also known as the Time Bar) to make the Playhead jump to that position.

Position Playhead using the Time Box

The Time Box is a field located at the upper left side of the Timeline Editor, which displays the Show’s current time in numeric values. Use the following methods to move the Playhead to a time value specified in the Time Box:

- Double-click or press [F2] to edit the numeric value in the Time Box.
- Double-click or press [F2], then press the [+ ] key and add the number of frames you want the Playhead to move forward. If the number entered is preceded by the [- ] key, the Playhead will jump backward. If the number entered exceeds 99, the time value will be
divided as follows: hours:minutes:seconds:frames. For example, entering + 122 will make the Playhead jump forward 1 second 22 frames.

**Other Ways to Position the Playhead**

It is possible to move the Playhead using other methods:

- Click on the transport buttons located to the left of the Timeline Editor window section to move the Playhead.
- Many keyboard shortcuts will move the Playhead. A list of the shortcuts linked to the Timeline module can be accessed by selecting {Help > Shortcut Keys > Timeline Shortcuts} in the Main Menu bar.
- Trigger a Cue containing a pre-recorded change to the Playhead’s position.
- Select a predefined Region by clicking on its entry in the Region list (located in the far left part of the Timeline editor window section) to make the Playhead jump to the Region’s location on the Timeline.

**2.5.2 Timeline Zoom and Navigation**

**Zoom and Navigation using the Mouse and Keyboard**

- Use the [Mouse Scroll] to zoom in on the Playhead’s location on the Timeline; or
- Press [Ctrl+Mouse Scroll] to zoom in on the cursor’s location on the Timeline.

**Zoom and Navigation using the Zoom Bar**

- Use the Zoom Bar located at the top of the Timeline to zoom in on sections of the Timeline.
- [Click+Drag] the white handles located at the Zoom Bar’s edges to change the zoom value.
- [Click+Drag] the center of the Zoom Bar to modify its view position.

**2.5.3 Re-center the Playhead**

- [Double-click] on the Zoom Bar to center the Timeline view on where the Playhead is positioned; or
- Press [F5] (the Timeline must be in focus) to re-center the Playhead.
2.5.4 Scroll and Pan on the Timeline

Scroll
To scroll up or down on the Timeline you can:

- Place the cursor in the Screen name column at the left of the Timeline; or
- Place the cursor on the scrollbar at the far right edge of the Timeline.

Pan
To pan left and right on the Timeline:

- Using the mouse, [Middle-click+Drag] anywhere in the Timeline’s tracks.

2.5.5 J K L

You can use the [J], [K] and [L] keys to control the Playhead speed during playback. Playhead speed can be increased up to 40 times its normal speed in both directions.

- Press the [J] key to reverse playback (1 times) speed.
- Press the [K] key to pause playback.
- Press the [L] key to playback forward at (1 times) speed.

2.5.6 Navigate Timeline Using Ins and Outs

Clip time boundaries (the In and Out points) can be used to navigate through the Timeline.

- Press [Ctrl+J] to make the Playhead jump backward to the next In or Out point on the Timeline.
2.6 Editing on the Timeline

2.6.1 Move Clips

Clips can be moved horizontally on the Timeline in order to change the timing of their occurrence. They can also be moved vertically through the Layers of the same Screen or from one Screen to another.

- [Left-click+Drag] a Clip to move it.
- [Left-click+Drag] on the Timeline to draw a selection frame around the Clips you want to move, then [Left-click+Drag] one of the Clips in the selected group to move the whole group.

Note: Clips can also be moved horizontally on the Timeline by first locking the Duration time slider and then by modifying the value of the In or the Out time sliders located in the Shared Clip Properties window section.

2.6.2 Change Clip Duration

Clip duration can be changed using any of the following methods:
● Place the cursor over the beginning or the end of a Clip (its In or Out point). The cursor’s appearance will change showing a double-ended arrow instead of the regular mouse pointer. [Left-click+Drag] the In or the Out point to change the Clip’s length (i.e. extend or reduce its duration). This method works as well when multiple Clips are selected.
● Click on the Clip to select it. Enter new values in the In and Out time sliders located in the Shared Clip Properties window section.

2.6.3 Set a Clip’s In or Out Point

Setting a Clip’s In or Out point will move it on the Timeline until it’s beginning or end matches the position specified by the Playhead’s location. The Clip’s duration will not be altered.

Set Clip In Point

● Click on a Clip to select it. Press [Ctrl+Home] to set the Clip’s In point; or
● [Right-click] on a Clip to open a contextual menu. Select {Edit > Set clip in point}.

Set Clip Out Point

● Click on a Clip to select it. Press [Ctrl+End] to set the Clip’s Out point; or
● [Right-click] on a Clip to open a contextual menu. Select {Edit > Set clip out point}.

2.6.4 Set Clip Fade In/Out Points

Setting a Clip’s Fade In point or Fade Out point will move the Clip on the Timeline until the highest part of the fade slope matches the current position of the Playhead.

Set Clip Fade In Point

1. Position the Playhead on the Timeline where you want the selected Clip’s fade in to be complete.
2. Click on the Clip to select it.
3. Set the Fade In point by using one of the following methods:
   ● Press [Ctrl+Shift+Home]; or
Select {Edit > Set clip in point} from the Timeline menu; or
[Right-click] on the Clip to open a contextual menu. Select {Edit > Set clip in point}.

Set Clip Fade Out Point
1. Position the Playhead on the Timeline where you want the selected Clip's fade out to start.
2. Click on the Clip to select it.
3. Set the Fade Out point by using one of the following methods:
   ● Press [Ctrl+Shift+End]; or
   ● Select {Edit > Set clip out point} from the Timeline menu; or
   ● [Right-click] on the Clip to open a contextual menu. Select {Edit > Set clip out point}.

Note: Clip fade in and fade out times are set in the Shared Clip Properties window section of the Timeline module.

2.6.5 Trim Clip In or Out Point
Trimming a Clip In or Out point will change the selected Clip’s duration by moving its beginning or end to match the Playhead’s current position. Multiple Clips can be trimmed at the same time.

Trim Clip In Point
   ● Click on a Clip to select it. Press [Ctrl+[ ] to trim the Clip’s In point; or
   ● [Right-click] on a Clip to open a contextual menu. Select {Edit > Trim clip in point}.

Trim Clip Out Point
   ● Click on a Clip to select it. Press [Ctrl+] ] to trim the Clip’s Out point; or
   ● [Right-click] on a Clip to open a contextual menu. Select {Edit > Trim clip out point}.

2.6.6 Duplicate Clip
Duplicating a selected Clip will create a copy of it in a newly created Layer located beneath it. It is possible to accomplish this operation multiple selected Clips.

   ● Click on a Clip to select it. Press [Ctrl+D] to duplicate the Clip; or
   ● Click on a Clip to select it. Select {Edit > Duplicate Clip} from the Timeline Editor menu.

When duplicating a Clip, it is also possible to position it in any Layer that exists.
- Click on a Clip to select it. Press [Ctrl+Left-click+Drag] to duplicate the Clip and position it in any Layer that exists.

### 2.6.7 Slice Clip

Slicing a Clip will separate it into two distinct Clips.

1. Position the Playhead on the Timeline where you want the Clip to be sliced.
2. Click on the Clip to select it.
3. Slice the Clip by using one of the following methods:
   - Press [Ctrl+B]; or
   - Select {Edit > Slice} from the Timeline menu; or
   - [Right-click] on the Clip to open a contextual menu. Select {Edit > Slice}.

Note: If the sliced Clip is a Media Clip, the In and Out time sliders for the new Media Clips created will be set to reflect the Playhead’s position when the slicing occurred. The In and Out time sliders for Media Clips are in the Media Properties window section.

### 2.6.8 Snapping

Snapping is a Timeline editing function that facilitates Clip alignment.

- Press [Shift] while moving a selected Clip to enable Snapping.

If Snapping is enabled, the Clip that you are moving on the Timeline will automatically align with or snap to the edge of another Clip in range. White vertical lines appear at the edges of the Clips that are in range.
Snapping can help ensure you don’t accidentally insert or overlay a Clip onto another when dragging Clips around within the Timeline.

Snapping also works between the edge of a Clip and the Playhead (not the other way around).

2.7 Inserting Cues on the Timeline

Cue Clips are used to insert pre-recorded Cues on the Timeline. Cue recording and editing is covered in another section of the manual. (See Section 1.2 Cue Recording in Chapter 4 Programming a Show.)

A Cue will be triggered whenever the Playhead intersects with the Cue Clip that is linked with it.

Follow the next steps to properly insert and adjust a Cue on the Timeline.

2.7.1 Add a Cue Clip

- [Right-click] in a Layer track to open the Clip Type contextual menu. Select {Add Cue};
- or
- Select a Layer by clicking on its entry in the Layers list. Select {File > Add Cue} from the Timeline Editor menu; or
- Select a Layer by clicking on its entry in the Layers list. Press [Ctrl+U]. Notice that the Cue Clip’s In point will match the position of the Playhead.

2.7.2 Adjust a Cue Clip’s Length and Position

- A Cue Clip’s length and position can be adjusted as per any other Clip types. Please refer to previous sections of the manual for detailed instructions. (See Section 2.5.1 Move Clips in Chapter 4 Programming a Show; as well as Section 2.5.2 Change Clip Duration in Chapter 4 Programming a Show.)

Note: A Cue Clip’s length and position should be determined using the following methods:
- The Cue Clip’s position has to match the moment at which you need it to be triggered.
- The Cue Clip’s duration should exceed 30 frames to make sure it’s registered even if poor server performances occur.
- The Cue Clip’s duration should be long enough to allow the operator to read its name in the Timeline.
- The Cue Clip’s duration should be short enough to avoid visually cluttering the Timeline.
2.7.3 Link the Cue Clip to a Pre-Programmed Cue

1. Click on the Cue Clip to select it. Properties specific to the selected Clip will appear in the top right window section of the Timeline module. (The window section should be named Clip Properties.)
2. Select the Cue you want to link to the Clip by clicking on its entry in the Select source cue list. You can use the search box or select an item from the Cue playlist dropdown menu to filter out unwanted Cues from the Select source cue list.

Once linked, the Cue Clip’s name (shown in the Timeline) will change to the Cue’s name. It should read as: **Cue # : name_of_the_Cue** (the Cue # is its unique ID number).

2.8 Universal Crossfade

The Universal Crossfade widgets can be found in the far left part of the Timeline Editor window section.

This function allows you to execute a crossfade from any point to another in the Timeline. If the Playhead jumps from any location to another on the Timeline, a smooth transition will occur. The number and type of Clips (Media, FX, Input Device) being read at each location does not matter; the system will still execute a smooth crossfade between the two states.

Enable Universal Crossfade

- Click on the [Enable] toggle to activate or deactivate the Universal Crossfade function.
Set Universal Crossfade Duration

- [Click+Drag] the Cross Fade Slider (measured in seconds) to set the Universal Crossfade duration.

Note: The Universal Crossfade function will only work if PHOTON detects a Playhead jump that has a duration greater than 1 second.

2.9 Timeline Duration

The Timeline’s duration is determined by the Sequence’s duration. By default, a Sequence has a duration of 2 hours. Every newly created Sequence will have this duration if the default value isn’t changed.

2.9.1 Change the Default Value for Sequence Duration

1. Open the Settings module by pressing [Alt+S] or by selecting {System > Settings}.
2. Click on the [General] tab.
3. Click on the Sequence time slider located underneath the Timeline window section to edit its default value.
4. Enter the new default values for Sequence duration using the keyboard. Values are expressed as follows: hours:minutes:seconds:frames
2.9.2 Change the Duration of a Sequence

1. [Right-click] on the Sequence tab to open a contextual menu.
2. Select {Properties} from the menu; a Sequence Properties window will open.
3. Click on the Duration time slider to edit its default value.
4. Enter the new default values for Sequence duration using the keyboard. Values are expressed as follows: hours:minutes:seconds:frames
5. Click on the [OK] button. The Timeline will be extended or reduced to match the Sequence’s duration.
6. A dialog box will open to tell you if some Clips are out of range now that the Sequence duration has been altered. This is non-destructive; if the Timeline’s duration is returned to its original format the Clips will be reintegrated.

Note: 30 hours is the maximum duration for a Sequence because this is the maximum value for Timecode data. 1 second and 1 frame (00:00:01:01) is the minimum duration for a Sequence. (This is arbitrary.)

2.10 Timeline Auto Loop

Playback will automatically stop by default when the Playhead reaches the end of a Sequence, PHOTON can be set to loop playback automatically. When the Playhead reaches the end of the Sequence it will automatically jump back at 00:00:00:00 and playback will resume.

Auto Loop a Sequence

1. [Right-click] on the Sequence tab to open a contextual menu.
2. Select {Properties} from the menu; a Sequence Properties window will open.
3. Click on the [Enable Auto Loop] toggle to enable the function.
4. Click on the [OK] button to close the window.

Note: It is possible to create a playback loop in a Sequence by placing a Cue Clip at its end. The pre-recorded Cue has to move the Playhead to the beginning of the Sequence.
2.11 Timeline Freerun

The Freerun function will activate media playback when the Playhead comes into contact with a Media Clip, even if the playback transport function is not enabled. Once activated, the Freerun function will affect the behavior of every Media Clip in the Timeline.

Activate Freerun

- Click on the [Free Run] toggle located in the Timeline Editor window section to enable Timeline Freerun.

Note: When used on an entire Timeline, this option is very useful as a creation tool. Free Run should not be used in a show.

2.12 Duplicating, Exporting and Importing a Sequence

A Sequence can be duplicated, and it can be exported or imported as a .seq file.
2.12.1 Duplicate a Sequence

1. [Right-click] on the Sequence tab to open a contextual menu.
2. Select {Duplicate} from the menu; this will create a copy of the Sequence.

Note: Problems related to Cues and Mappings might be experienced when duplicating a Sequence. Caution is advised.

2.12.2 Export a Sequence

1. [Right-click] on the Sequence tab to open a contextual menu.
2. Select {Export} from the menu. A dialog box will open and ask for the name and location of the exported Sequence.
3. Enter the exported Sequence file name and choose a location. Click on the [Save] button.

2.12.3 Import a Sequence

1. Select {File > Import sequence} from the Timeline Editor menu. A dialog box will open and ask which Sequence file to load.
2. Select the .seq file you want to load. Click on the [Open] button.

This action will add the imported Sequence as new tab in the Timeline.

Note: Importing a Sequence into another project is possible, but given that the Timeline is Screen-based, the 3D Scene objects corresponding to the Timeline Screens need to be present in the 3D Scene prior to the import. Cues will have to be rebuilt because they are project dependent for the most part.
1. Shadow

PHOTON features a module named Shadow that can record and playback the user’s interactions with its interface. It can be used to:

- document on-going projects;
- build templates you can exchange with colleagues; or
- provide info as a task-oriented reference tool.

While in Playback mode, the recorded interactions will affect the current state of your project. For example, if you playback a recorded action, the project’s state will revert to what it was when the action was first recorded. This behavior will allow you to load tutorial files that will teach you the software’s basics by animating the interface. You will also be able to export files containing recorded sets of actions that can be sent to other users and specialists for support.

Note: Always save your PHOTON Project before recalling any Sessions. When a Session is recalled or played back, the project’s state will change to reflect what is stored in the Session and all prior work will be erased.

1.1 Shadows and Sessions

Sessions are recordings of user interactions. Any interaction done with the mouse or keyboard can be recorded and can be played back. A Shadow is a container for Sessions, which makes it possible to select and group Sessions in sequential order.

This structure has been designed to facilitate the creation of Shadows, which are lists of individual tasks contained in a recorded Session. Even if it is possible to record multiple tasks within a Session, VYV recommends treating them as independent containers for single actions only, because it is possible to load previously saved Sessions into new Shadows to create complex sequences out of simple building blocks.

1.1.1 Default and Custom Shadows

Default Shadows are pre-recorded by VYV and packaged with our software. They cover most of the basic tasks a user will have to execute while building a typical project. Default Shadows should be seen as complementary to PHOTON’s technical documents. They cannot be modified.

Custom Shadows are user-generated and are meant for performing support operations and facilitating cooperation between user groups. Designed to allow UI recordings, Custom
Shadows can be used to identify software bugs, to share project design tricks or help spot UI manipulation mistakes.

1.2 Recording Sessions

Before recording Sessions make sure you have correctly created, selected and named a new Shadow.

Create a New Shadow

1. Open the Shadow module by pressing [Alt+Z] or by selecting {System > Shadow} in the module’s Main menu.
2. In the Shadow module, click on the [+] button located under Custom Shadows. A new Shadow will be created.
3. To select the new Shadow, click once on the new entry in the Custom Shadows list.
4. To change the new Shadow’s name using the keyboard, double-click on the new Shadow entry to open a text field.

Once a new Shadow has been created, selected and renamed, you will need to create, rename and select a new Session.

Create a New Session

1. To create a new Session in the Shadow module, click on the [+] button located on top of the Shadow breakdown list.
2. To select the new Session, click once on the new entry in the selected Shadow breakdown list.
3. To change the new Session’s name using the keyboard, double-click on the new entry to open a text field.

A new Session is now ready for data entry and UI recording.

1.2.1 Session Viewer

The Session Viewer is comprised of three sections:

- The top section contains the title of the selected Session. You can edit the title by clicking on the text field, but the Session’s name in the Shadow breakdown list will remain the same.
- The middle section is where you can write a description that will be linked to the UI recording you will eventually make. Click on the text field to enter your description.
- The bottom section will display modifier keys that will be used during the recording.
1.2.2 Record Options

This section contains a [Keyboard & Mouse] toggle that should be activated because you will record UI interactions. Once you have made sure the toggle is activated you can record your Session.

1.2.3 Recording a Session

- To record a Session, click on the [RECORD] button. When the recording is activated, the button will turn green.

Complete the sequence of actions with the UI you want to record, then click again on the [RECORD] button. Session recording will stop and the button will go back to its original state.
1.3 Playback Sessions

Once you have recorded Sessions (and eventually Shadows) you might want to play them back.

Before recalling any Session, make sure you saved a copy of your current project – by selecting {File > Save Project...} or by pressing [Ctrl+Shift+S] – because the Session will overwrite your project’s current state.

- Select the Shadow that contains the Session you want to recall by clicking on it in either the Default Shadows list or the Custom Shadows list.

1.3.1 Play Options

The Play Options window section contains two toggles. Before launching any pre-recorded Sessions, make sure the [Keyboard & Mouse] toggle is activated.

The [Minimize] toggle can be activated before recalling Sessions. If activated, the size of the Shadow module will be reduced to help you see the action.

1.3.2 Playback

You can playback Sessions to watch the UI animate itself and execute a pre-recorded action. Keyboard and mouse inputs are not blocked on playback, so you should refrain from using them while a Session is recalled.

1. Select the Session you want to playback by clicking on its name in the Shadow breakdown list.
2. Click on the play button [pixbutton].

1.3.3 Initial State Recall

To learn how to replicate steps that you previously watched, you might want to recall the state your project was in prior to a Session recording.

1. To recall a project’s initial state, select the Session you want to recall by clicking on its name in the Shadow breakdown list.
2. Click on the downward arrow button [pixbutton].
1.4 Export/Import Shadows and Sessions

Shadows and Sessions can be exported and imported to foster cooperation between users and simplify support operations. Shadows will be saved as .shd files, and Sessions will be saved as .ssd files.

**Import Custom Shadows**
- Click on the import button [pixbutton] located at the top of the Custom Shadows window section.

**Export Custom Shadows**
- Click on the export button [pixbutton] located at the top of the Custom Shadows window section.

**Import Custom Sessions**
- Click on the import button [pixbutton] located at the top of the selected Shadow breakdown list window section.

**Export Custom Sessions**
- Click on the export button [pixbutton] located at the top of the selected Shadow breakdown list window section.